The specifications and information regarding the products in this manual are subject to change without notice. All statements, information, and recommendations in this manual are believed to be accurate but are presented without warranty of any kind, express or implied. Users must take full responsibility for their application of any products.

The software license and limited warranty for the accompanying product are set forth in the information packet that shipped with the product and are incorporated herein by this reference. If you are unable to locate the software license or limited warranty, contact your Cisco representative for a copy.

The Cisco implementation of TCP header compression is an adaptation of a program developed by the University of California, Berkeley (UCB) as part of UCB's public domain version of the UNIX operating system. All rights reserved. Copyright © 1981, Regents of the University of California.

Notwithstanding any other warranty herein, all document files and software of these suppliers are provided “as is” with all faults. Cisco and the above-named suppliers disclaim all warranties, expressed or implied, including, without limitation, those of merchantability, fitness for a particular purpose and noninfringement or arising from a course of dealing, usage, or trade practice. In no event shall Cisco or its suppliers be liable for any indirect, special, consequential, or incidental damages, including, without limitation, lost profits or loss or damage to data arising out of the use or inability to use this manual, even if Cisco or its suppliers have been advised of the possibility of such damages.

Any Internet Protocol (IP) addresses and phone numbers used in this document are not intended to be actual addresses and phone numbers. Any examples, command display output, network topology diagrams, and other figures included in the document are shown for illustrative purposes only. Any use of actual IP addresses or phone numbers in illustrative content is unintentional and coincidental.

All printed copies and duplicate soft copies of this document are considered uncontrolled. See the current online version for the latest version.

Cisco has more than 200 offices worldwide. Addresses and phone numbers are listed on the Cisco website at www.cisco.com/go/offices.

Cisco and the Cisco logo are trademarks or registered trademarks of Cisco and/or its affiliates in the U.S. and other countries. To view a list of Cisco trademarks, go to this URL: www.cisco.com/go/trademarks. Third-party trademarks mentioned are the property of their respective owners. The use of the word partner does not imply a partnership relationship between Cisco and any other company. (1721R)

© 2018 Cisco Systems, Inc. All rights reserved.
CONTENTS

New and Changed Information vii

CHAPTER 1 Prepare to Install 1

Server Requirements 1
Cisco Product Requirements 1
Virtual Machine Requirements 2
Hardware and System Requirements 2
Supported Storage Models 3
Virtual Machine Specifications 3
VMware vSphere Feature Support 3
Reverse Proxy Server Requirements 4

License Requirements 4
Client Requirements 6
Client Hardware and System Requirements 6
Cisco Jabber Guest Plug-in Requirement 7
Supported Mobile Devices 8

Deployment Options 10
Network Topology 11
Call Control Flow 11
Media Flow 13
Media Flow: Cisco Expressway-E with Single NIC Deployment 13
Media Flow: Cisco Expressway-E with Dual NIC Deployment 14

Ports and Protocols 15
Ports and Protocols: Cisco Expressway-E with Single NIC Deployment 15
Ports and Protocols: Cisco Expressway-E with Dual NIC Deployment 17

Clustering Options 19
# Contents

**CHAPTER 2**

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Load Balancing Methods Available</td>
<td>20</td>
</tr>
<tr>
<td><strong>Install Cisco Jabber Guest Server</strong></td>
<td>23</td>
</tr>
<tr>
<td>Overview</td>
<td>23</td>
</tr>
<tr>
<td>Install Server</td>
<td>23</td>
</tr>
<tr>
<td>Install Server to vCenter Server</td>
<td>24</td>
</tr>
<tr>
<td>Install Server to ESXi, UC Virtualization Foundation, or UC Virtualization Hypervisor</td>
<td>25</td>
</tr>
<tr>
<td>Sign In to Cisco Jabber Guest Administration</td>
<td>26</td>
</tr>
<tr>
<td>Install Certificate</td>
<td>26</td>
</tr>
<tr>
<td>Install Certificate Signed by a Certificate Authority</td>
<td>27</td>
</tr>
<tr>
<td>Install Certificate with Additional Distinguished Name Information</td>
<td>28</td>
</tr>
<tr>
<td>Install Certificate That Includes the Intermediate Certificate or the Entire Certificate Trust Chain</td>
<td>29</td>
</tr>
<tr>
<td>Edit the Certificate Trust Chain</td>
<td>30</td>
</tr>
<tr>
<td>Generate New Self-Signed Certificate</td>
<td>31</td>
</tr>
<tr>
<td>Sign In to Cisco Jabber Guest Server CLI</td>
<td>32</td>
</tr>
<tr>
<td>Change Time Zone on Server</td>
<td>32</td>
</tr>
</tbody>
</table>

**CHAPTER 3**

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Perform Initial Setup</td>
<td>33</td>
</tr>
<tr>
<td>Configure Cisco Expressway-E and Cisco Expressway-C</td>
<td>33</td>
</tr>
<tr>
<td>Configure Cisco Expressway-E and Cisco Expressway-C: Cisco Expressway-E with Single NIC Deployment</td>
<td>33</td>
</tr>
<tr>
<td>Configure Cisco Expressway-E and Cisco Expressway-C: Cisco Expressway-E with Dual NIC Deployment</td>
<td>36</td>
</tr>
<tr>
<td>Change MTU Size</td>
<td>38</td>
</tr>
<tr>
<td>Configure Signaling and Media</td>
<td>39</td>
</tr>
<tr>
<td>Configure Signaling and Media: Cisco Expressway-E with Single NIC Deployment</td>
<td>39</td>
</tr>
<tr>
<td>Configure Signaling and Media: Cisco Expressway-E with Dual NIC Deployment</td>
<td>40</td>
</tr>
<tr>
<td>Configure Static NAT Mode on Cisco Expressway-E</td>
<td>41</td>
</tr>
<tr>
<td>Configure TURN Credential Provisioning</td>
<td>42</td>
</tr>
<tr>
<td>Set Up TURN Server Information</td>
<td>42</td>
</tr>
<tr>
<td>Set FQDN of Cisco Jabber Guest Server</td>
<td>43</td>
</tr>
<tr>
<td>Set Domain Used for Links</td>
<td>44</td>
</tr>
<tr>
<td>Customize Cisco Jabber Guest Clients</td>
<td>44</td>
</tr>
</tbody>
</table>
Customize Long Polling and Call Session Expires  45

CHAPTER 4  Upgrade Cisco Jabber Guest Server  47
  Upgrade Cisco Jabber Guest Server  47

CHAPTER 5  Configure High Availability and Scalability  49
  Cluster  49
    Create Cluster  49
    Change IP Address or Hostname of Server in Cluster  50
    Demote Primary Server to Secondary Server  51
    Upgrade Cluster  52
    Remove Server from Cluster  54
  Configure Load Balancing  55
    Configure Round-Robin DNS Load Balancing  55
    Change the SIP Call Throttle Limit  56
    Configure Round-Robin CSV Loading Balancing  56
    Configure HTTP Load Balancing  57
    Configure Round-Robin TURN Port Range Load Balancing  57

CHAPTER 6  Post-Install Configuration Changes  59
  Change Virtual Machine Properties of a vCenter-hosted Server  59
  Change Virtual Machine Properties of a UC Virtualization Foundation, UC Virtualization Hypervisor, or ESXi-hosted Server  59

CHAPTER 7  Troubleshoot  61
  Locate chip.log File  61
  Locate chip.dmp File  62
  Reset Admin Password for Cisco Jabber Guest Administration  62
  Reset Root Password for Cisco Jabber Guest Server  62
  Audio and Video Issues  64
    One-Way Video When Using VPN  64
    No Audio or Video on Single NIC Deployment  64
    Don't See Screen Share in Production Deployment  65
    Check BFCP Settings for Screen Sharing  65
Don't See Screen Share in Lab Deployment  65
Call Links Redirect to Cisco Expressway-E Web Page  66
Plug-in Crashes  66
Jabber Guest Web Administrator Page Does Not Load  66
Error Messages  67

CHAPTER 8  Reference  71
Cisco Unified Communications Manager  71
Cisco Unified Communications Manager/Cisco Expressway Configuration Checklist  72
# New and Changed Information

<table>
<thead>
<tr>
<th>Description of Change</th>
<th>Date</th>
<th>Where Documented</th>
</tr>
</thead>
<tbody>
<tr>
<td>Added iPhone 8, iPhone 8 plus and iPhone X to the list of supported mobile devices</td>
<td>December 2017</td>
<td>Prepare to Install chapter&gt; Clients Requirements section:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Supported mobile devices &gt; iOS Supported Devices</td>
</tr>
<tr>
<td>Added MD5 sign in restriction to troubleshoot 'Failed to acquire TURN credentials' error message.</td>
<td>December 2017</td>
<td>Troubleshoot chapter&gt; Error messages section.</td>
</tr>
<tr>
<td>Updated license requirement</td>
<td>May 2017</td>
<td>License Requirements</td>
</tr>
<tr>
<td>Added additional information to the Note</td>
<td>May 2017</td>
<td>Install Server to ESXi, UC Virtualization Foundation, or UC Virtualization Hypervisor</td>
</tr>
<tr>
<td>Added iPad device to the table</td>
<td>May 2017</td>
<td>iOS Supported Devices</td>
</tr>
<tr>
<td>Firefox (50 and later) will require an extension and an add-on to be installed for full Jabber Guest functionality</td>
<td>December 2016</td>
<td>Prepare to Install chapter&gt; Clients Requirements section:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Cisco Jabber Guest Plug-in Requirement</td>
</tr>
<tr>
<td>Mac OS requirements changed to OS X 10.10 or later</td>
<td>December 2016</td>
<td>Prepare to Install chapter&gt; Clients Requirements section:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Table 4: Mac OS X 10.10 or later</td>
</tr>
<tr>
<td>Added iPhone 7, iPhone 7 plus and iPhone SE to the list of supported mobile devices</td>
<td>December 2016</td>
<td>Prepare to Install chapter&gt; Clients Requirements section:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Supported mobile devices &gt; iOS Supported Devices</td>
</tr>
<tr>
<td>CentOS requirements changed from 6.7 to 6.8</td>
<td>December 2016</td>
<td>Prepare to Install chapter&gt; Virtual Machine Requirements section:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Table 1: CentOS 6.8 64-bit</td>
</tr>
<tr>
<td>Added a hyperlink reference to Cisco Expressway IP port Usage for Firewall Traversal Guide</td>
<td>December 2016</td>
<td>Ports and Protocols</td>
</tr>
</tbody>
</table>
Prepare to Install

Cisco Jabber Guest can be deployed in combination with Cisco Expressway-E and Cisco Expressway-C or in combination with Cisco VCS-E and VCS-C. To simplify the documentation, we reference only Cisco Expressway-E and Cisco Expressway-C throughout this guide.

The mobile and web clients use the same interfaces when interacting with Cisco Expressway/Cisco TelePresence Video Communication Server (VCS) and Cisco Jabber Guest. To simplify the documentation, we reference only the web client throughout this guide.

- Server Requirements, on page 1
- License Requirements, on page 4
- Client Requirements, on page 6
- Deployment Options, on page 10
- Network Topology, on page 11
- Ports and Protocols, on page 15
- Clustering Options, on page 19
- Load Balancing Methods Available, on page 20

Server Requirements

Cisco Product Requirements

Deploy Cisco Jabber Guest with an existing Cisco Unified Communications Manager installation.

To allow Cisco Jabber Guest to access devices located inside the enterprise firewall, deploy the following:

- Cisco Unified Communications Manager 8.6.x or later
  Cisco Jabber Guest requires that your Cisco Unified Communications Manager be configured to work with Cisco Expressway.

- Cisco Jabber Guest Server

- Cisco Expressway-C X8.2 or later

- Cisco Expressway-E X8.2 or later
**Virtual Machine Requirements**

Cisco Jabber Guest is deployed as a virtual server using the Open Virtualization Format (OVF) standard for packaging and distributing virtual appliances that run in a virtual environment. It requires VMware vSphere as the hypervisor. Cisco publishes the distribution as an OVF file with the file extension .OVA, which stands for Open Virtual Appliance. This file contains the OVF template for the application. The OVF template defines the virtual machine’s hardware and is preloaded with required software.

**Hardware and System Requirements**

- A server platform that meets VMware’s Compatibility Guide for VMware vSphere 5.x or later is required. The Cisco Jabber Guest virtual machine uses a 64-bit distribution of CentOS 6.8. Make sure that the server platform uses CPUs that are capable of 64-bit instructions.

- Cisco Jabber Guest Server is supported on any Full UC Performance CPU, beginning with Intel Xeon Processor 5600 with a minimum physical core speed of 2.53 GHz or higher and any Restricted UC Performance CPU, beginning with Intel Xeon Processor E5 2609 v1 with a minimum physical core speed of 2.4 GHz or higher. For more information on Full UC performance CPUs and Restricted UC Performance CPUs, see the Processors/CPUs section in UC Virtualization Supported Hardware.

- Cisco Jabber Guest is allowed on server models meeting required specifications, including Cisco Business Edition 6000 (BE6000), Cisco Business Edition 7000 (BE7000), and UC on UCS Tested Reference Configurations with a Full UC Performance CPU. BE6000M (M2) UCS C200 M2 TRC#1 is not supported. For more information, see Virtualization for Cisco Jabber Guest Server. Cisco Jabber Guest Server must follow the application co-residency and virtual-to-physical sizing rules in the Unified Communications Virtualization Sizing Guidelines.

- Cisco Jabber Guest supports all virtualization software described in Purchasing/Sourcing Options for Required Virtualization Software.

• See the VMware developer documentation for additional configuration and hardware requirements. We highly recommend using the Cisco Unified Computing System (CUCS) to simplify and maximize performance.

Related Topics
Processors/CPUs section in UC Virtualization Supported Hardware
Virtualization for Cisco Jabber Guest Server
Unified Communications Virtualization Sizing Guidelines
Purchasing/Sourcing Options for Required Virtualization Software

Supported Storage Models

Virtual Machine Specifications

Table 1: Virtual Machine Specifications

<table>
<thead>
<tr>
<th>RAM</th>
<th>CPU</th>
<th>Storage</th>
<th>Operating System</th>
<th>CPU Resource Allocation</th>
<th>Memory Resource Allocation</th>
</tr>
</thead>
<tbody>
<tr>
<td>4 GB</td>
<td>2 logical CPUs with 1 core each</td>
<td>100 GB</td>
<td>CentOS 6.8 64-bit</td>
<td>Default (not defined)</td>
<td>Default (not defined)</td>
</tr>
</tbody>
</table>

VMware vSphere Feature Support

The following VMware vSphere features are supported:

• VM OVA template deployment (using the Cisco-provided Cisco Jabber Guest OVA)
• VMware vMotion
• VMware vSphere Distributed Switch (vDS)
• VMware Dynamic Resource Scheduler (DRS)
• VMware Storage vMotion (Storage DRS)
• VMware Virtual Machine Snapshots

You can restart Cisco Jabber Guest on a different VMware ESXi host and create or revert VMware Snapshots as long as the application was shut down without any issues before moving or taking a snapshot.

The following VMware vSphere features have not been tested with Cisco Jabber Guest:

• VMware Site Recovery Manager (SRM)
• VMware Consolidated Backup (VCB)
• VMware Data Recovery (VDR)
• VMware Dynamic Power Management (Cisco Jabber Guest must be configured to run 24/7)
• Long Distance vMotion (vMotion over a WAN)
The following VMware vSphere and third-party features are not supported with Cisco Jabber Guest:

- VMware Fault Tolerance (FT)
- VMware Hot Add
- Copying a Cisco Jabber Guest virtual machine (must use OVA to deploy new server)
- Configuring Cisco Jabber Guest with multiple virtual network interface controllers (vNICs)
- Third-party Virtual to Physical (V2P) migration tools
- Third-party deployment tools

Reverse Proxy Server Requirements

The Cisco Expressway-E and Cisco Expressway-C can be used to tunnel HTTP from the Cisco Jabber Guest client to the Cisco Jabber Guest server. If a third-party reverse proxy is used in front of the Cisco Expressway-E, configure it to proxy only the following URL types:

- /call
- /jabberc (used for HTTP/call control)

Configure the reverse proxy to redirect any HTTP requests to HTTPS.

License Requirements

Cisco Jabber Guest is licensed and obtained through User Connect Licensing (UCL), Cisco Unified Workspace Licensing (CUWL), and other ordering mechanisms. Contact a sales representative from a Cisco partner or from Cisco for ordering details. No license keys are provided or required for the Cisco Jabber Guest software.

The following table describes the license requirements for using Cisco Expressway with Cisco Jabber Guest.
### Table 2: License Requirements for Using Cisco Expressway with Cisco Jabber Guest

<table>
<thead>
<tr>
<th>License</th>
<th>Requirement</th>
<th>Note</th>
</tr>
</thead>
</table>
| Rich Media Session licenses | • For Cisco Expressway X8.7.3 or earlier, 2 Rich Media Session licenses are required per Cisco Jabber Guest session:  
  • 1 Rich Media Session license on the Cisco Expressway-E for each Cisco Jabber Guest session  
  • 1 Rich Media Session license on the Cisco Expressway-C for each Cisco Jabber Guest session  
  • For Cisco Expressway X8.8 or later, 1 Rich Media Session license on the Cisco Expressway-E is required for each Cisco Jabber Guest session | When you order Cisco Expressway, a TURN relay license is included. |
| TURN relay license       | TURN licensed on Cisco Expressway                                             | When you order Cisco Expressway, an AN license is included.          |
| Advanced Networking (AN) license | If Cisco Jabber Guest is installed in a dual-NIC deployment, an AN license is required on Cisco Expressway. | When you order Cisco Expressway, an AN license is included.          |

The following table describes the license requirements for using Cisco TelePresence Video Communication Server (VCS) with Cisco Jabber Guest.

### Table 3: License Requirements for Using Cisco VCS with Cisco Jabber Guest

<table>
<thead>
<tr>
<th>License</th>
<th>Requirement</th>
<th>Note</th>
</tr>
</thead>
</table>
| Traversal call licenses  | 2 traversal call licenses are required per Cisco Jabber Guest session:  
  • 1 traversal call license on the VCS-E for each Cisco Jabber Guest session  
  • 1 traversal call license on the VCS-C for each Cisco Jabber Guest session | When you order Cisco Expressway, a TURN relay license is included. |
### Client Requirements

**Client Hardware and System Requirements**

Users require a multimedia-capable computer with a camera and microphone that support the following software and hardware requirements:

*Table 4: Client Requirements*

<table>
<thead>
<tr>
<th>License</th>
<th>Requirement</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>TURN relay license</td>
<td>TURN licensed on Cisco VCS</td>
<td>When you order Cisco VCS, a TURN relay license is included.</td>
</tr>
<tr>
<td>Dual Network Interface (DI)</td>
<td>If Cisco Jabber Guest is installed in a dual-NIC deployment, a DI license is required on Cisco VCS.</td>
<td>When you order Cisco VCS, a DI license is not included. Specifically select this license.</td>
</tr>
</tbody>
</table>
### Windows Requirements

<table>
<thead>
<tr>
<th>Browsers</th>
<th>Mac Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mozilla Firefox 10 or later</td>
<td>Safari 7 to 11</td>
</tr>
<tr>
<td>Google Chrome 18 or later</td>
<td>Mozilla Firefox 10 or later²</td>
</tr>
<tr>
<td>Microsoft Internet Explorer 8 or later (32-bit, or 64-bit running 32-bit tabs only. 64-bit browsers running 64-bit tabs are not supported.)</td>
<td>Google Chrome 18 or later</td>
</tr>
</tbody>
</table>

**Note**

1. On Windows 8 or later, only the desktop version is supported. The Metro version won't work.
2. Microsoft Internet Explorer 8 exhibits some minor layout differences because of certain browser limitations.
3. You may encounter video frame layout issues in Windows 7 and Windows 8, if the screen display scaling is not set at 100%. This is due to an OS limitation and does not occur in Windows 8.1 or later.

### Cisco Jabber Guest Plug-in Requirement

The Cisco Jabber Guest solution includes a browser plug-in that is downloaded and installed by the caller on the local machine. For Google Chrome and Firefox (50 and later), the web page prompts the user to install

---

¹ To configure Internet Explorer on Windows 8 or later to open the desktop version by default, do the following:

1. Open Microsoft Internet Explorer.
2. From the **Tools** menu, click **Internet options**.
3. Click the **Programs** tab.
4. Under **Opening Internet Explorer**, choose **Always in Internet Explorer on the desktop**.

² Currently, a known issue with Firefox on Mac OS X prevents full-screen video. This option is not offered for this combination of browser and operating system.
the Chrome/Firefox Extension and the Cisco Jabber Guest Add-on. For all other browsers, the Cisco Jabber Guest web page prompts the caller to download and install the plug-in the first time the service is used. New plug-ins are periodically made available with fixes and new functionality. The caller is prompted to download and install the new plug-in the next time an attempt is made to place a call.

Supported Mobile Devices

Android Supported Devices

We support Cisco Jabber Guest for Android on audio and video for the following Android devices and operating systems:

<table>
<thead>
<tr>
<th>Make</th>
<th>Model</th>
<th>Android OS Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Google</td>
<td>Nexus 5</td>
<td>4.4.x, 5.0, 5.1</td>
</tr>
<tr>
<td></td>
<td>Nexus 6</td>
<td>5.0, 5.1</td>
</tr>
<tr>
<td></td>
<td>Nexus 7 2013 version or later</td>
<td>4.4.x, 5.0, 5.1</td>
</tr>
<tr>
<td></td>
<td>Nexus 10</td>
<td>4.4.x, 5.0, 5.1</td>
</tr>
<tr>
<td>HTC</td>
<td>One (M7)</td>
<td>4.4.x</td>
</tr>
<tr>
<td></td>
<td>One Max</td>
<td>4.4.x</td>
</tr>
<tr>
<td></td>
<td>One (M8)</td>
<td>4.4.x</td>
</tr>
<tr>
<td>LG</td>
<td>G2</td>
<td>4.2.2–5.0.x, 5.1</td>
</tr>
<tr>
<td></td>
<td>G3</td>
<td>4.2.2–5.0.x, 5.1</td>
</tr>
<tr>
<td>Motorola</td>
<td>Moto G</td>
<td>4.4.x</td>
</tr>
<tr>
<td>Make</td>
<td>Model</td>
<td>Android OS Required</td>
</tr>
<tr>
<td>---------</td>
<td>------------------------</td>
<td>---------------------</td>
</tr>
<tr>
<td>Samsung</td>
<td>Galaxy Note II</td>
<td>4.2–4.4.x</td>
</tr>
<tr>
<td></td>
<td>Galaxy Note 3</td>
<td>4.3–4.4.x</td>
</tr>
<tr>
<td></td>
<td>Galaxy Note 4</td>
<td>4.4.x</td>
</tr>
<tr>
<td></td>
<td>Galaxy Note Pro 12.2</td>
<td>4.4.x</td>
</tr>
<tr>
<td></td>
<td>Galaxy Rugby Pro</td>
<td>4.2.2–4.4.x</td>
</tr>
<tr>
<td></td>
<td>Galaxy S II</td>
<td>4.1.2–4.4.x</td>
</tr>
<tr>
<td></td>
<td>Galaxy S III</td>
<td>4.1.2–4.4.x</td>
</tr>
<tr>
<td></td>
<td>Galaxy S4</td>
<td>4.2.2–4.4.x</td>
</tr>
<tr>
<td></td>
<td>Galaxy S4 mini</td>
<td>4.2.2–4.4.x</td>
</tr>
<tr>
<td></td>
<td>Galaxy S5</td>
<td>4.4.x</td>
</tr>
<tr>
<td></td>
<td>Galaxy S5 mini</td>
<td>4.4.x</td>
</tr>
<tr>
<td></td>
<td>Galaxy Tab 3 8.0</td>
<td>4.4.x</td>
</tr>
<tr>
<td></td>
<td>Galaxy Tab 4 7.0, 8.0, and 10.1</td>
<td>4.4.x</td>
</tr>
<tr>
<td></td>
<td>Galaxy Tab Pro 8.4 and 10.1</td>
<td>4.4.x</td>
</tr>
<tr>
<td></td>
<td>Galaxy Tab S 8.4 and 10.5</td>
<td>4.4.x</td>
</tr>
<tr>
<td>Sony</td>
<td>Xperia M2</td>
<td>4.3</td>
</tr>
<tr>
<td></td>
<td>Xperia Z1</td>
<td>4.2–4.4.x</td>
</tr>
<tr>
<td></td>
<td>Xperia ZR/A</td>
<td>4.1.2–4.4.x</td>
</tr>
<tr>
<td></td>
<td>Xperia Z2</td>
<td>4.4.x</td>
</tr>
<tr>
<td></td>
<td>Xperia Z2 tablet</td>
<td>4.4.x</td>
</tr>
<tr>
<td></td>
<td>Xperia Z3</td>
<td>4.4.x</td>
</tr>
</tbody>
</table>

We support Cisco Jabber Guest for Android with tested Android devices. Although other devices are not officially supported, you may be able to use Cisco Jabber Guest for Android with other devices.

**iOS Supported Devices**

Cisco Jabber Guest is supported on iOS 8.0 or later.

The following table lists the iOS mobile devices that Cisco Jabber Guest supports:

<table>
<thead>
<tr>
<th>iPad</th>
<th>iPhone</th>
</tr>
</thead>
<tbody>
<tr>
<td>iPad 2</td>
<td>iPhone 4s</td>
</tr>
</tbody>
</table>
### Deployment Options

Cisco Jabber Guest supports two deployments:

- Cisco Expressway-E with a single NIC—SIP traffic goes to the Cisco Expressway-C and media flows over a port range between the Cisco Expressway-E and the Cisco Expressway-C.

- Cisco Expressway-E with dual NIC—SIP traffic goes to the Cisco Expressway-E and media flows through the traversal zone between the Cisco Expressway-E and the Cisco Expressway-C.

---

**Important**

Only the Cisco Expressway-E with dual NIC deployment supports NAT/PAT between the Cisco Expressway-E and the Cisco Expressway-C.

---

**Lab Deployment**

Cisco Jabber Guest can be pointed directly to Cisco Unified Communications Manager for lab deployments only; configure a SIP trunk on Cisco Unified Communications Manager for this deployment. This option is best suited to a lab deployment in which the goal is to familiarize yourself with Cisco Jabber Guest without the additional overhead of configuring Expressway. However, without configuring Expressway, Cisco Jabber Guest is not supported in a production environment.

<table>
<thead>
<tr>
<th>iPad</th>
<th>iPhone</th>
</tr>
</thead>
<tbody>
<tr>
<td>iPad 3</td>
<td>iPhone 5</td>
</tr>
<tr>
<td>iPad 4</td>
<td>iPhone 5c</td>
</tr>
<tr>
<td>iPad Air</td>
<td>iPhone 5s</td>
</tr>
<tr>
<td>iPad Air 2</td>
<td>iPhone 6</td>
</tr>
<tr>
<td>iPad mini</td>
<td>iPhone 6 Plus</td>
</tr>
<tr>
<td>iPad mini 2</td>
<td>iPhone 6s</td>
</tr>
<tr>
<td>iPad mini 3</td>
<td>iPhone 6s Plus</td>
</tr>
<tr>
<td>iPad mini 4</td>
<td>iPhone 7</td>
</tr>
<tr>
<td>iPad Pro</td>
<td>iPhone 7 Plus</td>
</tr>
<tr>
<td>iPad</td>
<td>iPhone SE</td>
</tr>
<tr>
<td></td>
<td>iPhone 8</td>
</tr>
<tr>
<td></td>
<td>iPhone 8 Plus</td>
</tr>
<tr>
<td></td>
<td>iPhone X</td>
</tr>
</tbody>
</table>
Network Topology

Overview of Cisco Expressway-E with Single NIC Deployment

- SIP traffic is sent to the Cisco Expressway-C.
- Cisco Expressway-E is single NIC only.
- Cisco Expressway-E in static NAT mode is optional and requires additional configuration on the Cisco Jabber Guest server.
- Cisco Expressway-E is used for TURN services and reverse proxy, not call control.
- Media flows between the Cisco Expressway-E and the Cisco Expressway-C over port range, not a traversal zone.

Overview of Cisco Expressway-E with Dual NIC Deployment

- SIP traffic is sent to the Cisco Expressway-E.
- Cisco Expressway-E is dual NIC only.
- Cisco Expressway-E in static NAT mode is optional and requires additional configuration on the Cisco Jabber Guest server.
- Cisco Expressway-E is used for TURN services, reverse proxy, and call control.
- Media flows between the Cisco Expressway-E and the Cisco Expressway-C through a traversal zone.

In a production environment, Cisco Jabber Guest requires that your Cisco Unified Communications Manager be configured to work with Cisco Expressway.

Note

If Cisco Expressway-E is used for reverse proxy functionality, the Cisco Jabber Guest URL looks like https://expressway-e.example.com/call where expressway-e.example.com is the FQDN of Cisco Expressway-E.

Call Control Flow

The following are examples of call control flow for the two supported deployments of Cisco Jabber Guest Server.
Cisco Expressway-E with Dual NIC Deployment

SIP flows between the Cisco Jabber Guest server and the Cisco Expressway-E. This requires bi-directional TCP traffic between the two servers over 5060 (SIP over TCP) or 5061 (SIP over TLS). The SIP traffic then goes over the traversal zone to the Cisco Expressway-C.

We recommend that you disable SIP and H.323 application-level gateways on routers/firewalls carrying network traffic to or from a Cisco Expressway-E.

**Important**

Because media hairpins between the two Cisco Expressway-E NICs, the TURN traffic and SIP traffic must reside on the same Cisco Expressway-E server. You must configure the static NAT address, DMZ external address, and DMZ internal address of the Cisco Expressway-E on the Cisco Jabber Guest server.

**Related Topics**

Configure Signaling and Media: Cisco Expressway-E with Single NIC Deployment, on page 39
Configure Signaling and Media: Cisco Expressway-E with Dual NIC Deployment, on page 40
Media Flow

The web client uses TURN relays allocated on the Cisco Expressway-E to tunnel media into the enterprise. Media is sent and received in STUN encapsulated packets to the TURN server through UDP port 3478. TURN relay credentials are acquired and used as follows:

• The Cisco Jabber Guest client allocates a call resource through HTTP to the Cisco Jabber Guest server.
• The Cisco Jabber Guest server requests short-term TURN credentials from the Cisco Expressway-C through a secure HTTP request. Administrator credentials are used for authentication. The configured domain must be on the Cisco Expressway-C with Jabber Guest service enabled.
• The Cisco Expressway-C creates the TURN credential and passes it to the Cisco Jabber Guest server.
• The Cisco Expressway-C propagates the TURN credential to the Cisco Expressway-E through the SSH tunnel (port 2222).
• The Cisco Jabber Guest server responds to the Cisco Jabber Guest client with the TURN credential and TURN server (Cisco Expressway-E) address (DNS or IP).
• The Cisco Jabber Guest client uses the TURN credential to allocate the TURN relay on the TURN server.

Media Flow: Cisco Expressway-E with Single NIC Deployment

The following diagram is an example of the media flow for a Cisco Expressway-E with single NIC deployment of Cisco Jabber Guest.

Figure 3: Cisco Jabber Guest Media Flow: Cisco Expressway-E with Single NIC Deployment

Cisco Jabber Guest media does not go through the traversal link between Cisco Expressway-E and Cisco Expressway-C.
If the Cisco Expressway-E is behind a NAT, additional configuration is required on the Cisco Jabber Guest server to avoid the media flowing to the static NAT address. Turn on **Static NAT mode** and configure the static NAT address and DMZ external address of the Cisco Expressway-E on the Cisco Jabber Guest server. This allows media to be sent to the DMZ external address of the Cisco Expressway-E, avoiding NAT reflection on the outside firewall.

**Important**

**Related Topics**

Configure Static NAT Mode on Cisco Expressway-E, on page 41

**Media Flow: Cisco Expressway-E with Dual NIC Deployment**

The following diagram is an example of the media flow for a Cisco Expressway-E with dual NIC deployment of Cisco Jabber Guest.

*Figure 4: Cisco Jabber Guest Media Flow: Cisco Expressway-E with Dual NIC Deployment*

Media flows through the traversal zone between the Cisco Expressway-C and the internal NIC of the Cisco Expressway-E. It hairpins on the Cisco Expressway-E to the external NIC of the Cisco Expressway-E, and then is STUN/TURN wrapped before being sent to the client browser.

**Important**

**Related Topics**

Configure Static NAT Mode on Cisco Expressway-E, on page 41
Ports and Protocols

- HTTP and HTTPS traffic from Cisco Jabber Guest clients in the Internet is sent to ports 80 and 443 TCP respectively. Therefore the firewall between the Cisco Expressway-E and the public Internet must translate destination port 80 to 9980 and destination port 443 to 9443 for all TCP traffic that targets the Cisco Expressway-E address.

- The Cisco Expressway-E redirects HTTP requests on port 9980 to HTTPS on 9443.

- 80/443 TCP are the standard HTTP/S administration interfaces on the Expressway. If the Cisco Expressway-E is administered from systems located in the Internet, then the firewall translation must also distinguish by source address and must not translate the destination port of traffic arriving from those management systems.

- You also need to ensure that appropriate DNS records exist so that the Cisco Jabber Guest client can reach the Cisco Expressway-E. The FQDN of the Cisco Expressway-E in DNS must include the Cisco Jabber Guest domain. The Cisco Jabber Guest domain is the domain that is configured on the Cisco Expressway-C.

- For more information on port usage for Firewall Traversal, refer to the Cisco Expressway IP Port Usage for Firewall Traversal Guide.

## Ports and Protocols: Cisco Expressway-E with Single NIC Deployment

<table>
<thead>
<tr>
<th>Purpose</th>
<th>Protocol</th>
<th>Internet Endpoint (Source)</th>
<th>Cisco Expressway-E (Listening)</th>
</tr>
</thead>
<tbody>
<tr>
<td>HTTP</td>
<td>TCP</td>
<td>TCP source port</td>
<td>9980 (read the following Important note)</td>
</tr>
<tr>
<td>HTTPS proxy</td>
<td>TLS</td>
<td>TCP source port</td>
<td>9443 (read the following Important note)</td>
</tr>
</tbody>
</table>
| TURN Server (control and media relays) | UDP      | UDP source port            | 3478³  
                              |          |                            | 3478–3483  
                              |          |                            | 4

³ For small and medium Cisco Expressway-E deployments  
⁴ For large Cisco Expressway-E deployments
• The Cisco Expressway-E administrator currently uses port 80 and therefore, incoming requests from the Cisco Jabber Guest client to Cisco Expressway-E on port 80 must be remapped to port 9980 using a firewall (or similar) in front of Cisco Expressway-E. For the mobile client, using 9980 in call links is not supported; you must use port remapping on your firewall to remap port 80 to port 9980.

• The Cisco Expressway-E administrator currently uses port 443 and therefore, incoming requests from the Cisco Jabber Guest client to Cisco Expressway-E on port 443 must be remapped to port 9443 using a firewall (or similar) in front of Cisco Expressway-E. For the mobile client, using 9443 in call links is not supported; you must use port remapping on your firewall to remap port 443 to port 9443.

---

**Important**

**Set Domain Used for Links, on page 44**

**Table 6: Outbound from Cisco Expressway-C (Private) to Cisco Expressway-E (DMZ)**

<table>
<thead>
<tr>
<th>Purpose</th>
<th>Protocol</th>
<th>Cisco Expressway-C (Source)</th>
<th>Cisco Expressway-E (Destination)</th>
</tr>
</thead>
<tbody>
<tr>
<td>SSH (HTTP/S tunnels)</td>
<td>TCP</td>
<td>Ephemeral port</td>
<td>2222 (not configurable)</td>
</tr>
<tr>
<td>Traversal zone SIP signaling</td>
<td>TLS</td>
<td>25000–29999</td>
<td>7001</td>
</tr>
<tr>
<td>Media&lt;sup&gt;5&lt;/sup&gt;</td>
<td>UDP</td>
<td>36000–59999</td>
<td>24000–29999</td>
</tr>
</tbody>
</table>

<sup>5</sup> By default, media is sent to the NAT interface unless the Cisco Jabber Guest server is configured for static NAT mode.

**Table 7: Inbound from Cisco Expressway-E (DMZ) to Cisco Expressway-C (Private)**

<table>
<thead>
<tr>
<th>Purpose</th>
<th>Protocol</th>
<th>Cisco Expressway-E (Source)</th>
<th>Cisco Expressway-C (Destination)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Media</td>
<td>UDP</td>
<td>24000–29999</td>
<td>36000–59999</td>
</tr>
</tbody>
</table>

---

**Important**

• Inbound firewall rules are required to allow media to flow from the Cisco Expressway-E to Cisco Expressway-C.

• You may find that two-way media can still be established even if the inbound from Cisco Expressway-E (DMZ) to Cisco Expressway-C (private) firewall rules are not applied. This is because the outbound media creates a pinhole in the firewall; however, these rules are required to support uni-directional media (that is, only from outside to inside).

**Table 8: From Cisco Expressway-C to Cisco Jabber Guest**

<table>
<thead>
<tr>
<th>Purpose</th>
<th>Protocol</th>
<th>Cisco Expressway-C (Source)</th>
<th>Cisco Jabber Guest (Destination)</th>
</tr>
</thead>
<tbody>
<tr>
<td>HTTP</td>
<td>TCP</td>
<td>Ephemeral port</td>
<td>80</td>
</tr>
</tbody>
</table>
Table 9: From Cisco Jabber Guest to Cisco Expressway-C

<table>
<thead>
<tr>
<th>Purpose</th>
<th>Protocol</th>
<th>Cisco Expressway-C (Source)</th>
<th>Cisco Jabber Guest (Destination)</th>
</tr>
</thead>
<tbody>
<tr>
<td>HTTPS</td>
<td>TLS</td>
<td>Ephemeral port</td>
<td>443</td>
</tr>
<tr>
<td>SIP</td>
<td>TCP/TLS</td>
<td>Ephemeral port</td>
<td>5060 (SIP over TCP) 5061 (SIP over TLS)</td>
</tr>
</tbody>
</table>

Table 10: Inbound from Public Internet to Cisco Expressway-E (DMZ)

<table>
<thead>
<tr>
<th>Purpose</th>
<th>Protocol</th>
<th>Internet Endpoint (Source)</th>
<th>Cisco Expressway-E (Listening)</th>
</tr>
</thead>
<tbody>
<tr>
<td>HTTP</td>
<td>TCP</td>
<td>TCP source port</td>
<td>9980 (read the following Important note)</td>
</tr>
<tr>
<td>HTTPS proxy</td>
<td>TLS</td>
<td>TCP source port</td>
<td>9443 (read the following Important note)</td>
</tr>
<tr>
<td>TURN Server (control and media relays)</td>
<td>UDP</td>
<td>UDP source port</td>
<td>3478&lt;sup&gt;6&lt;/sup&gt; 3478–3483&lt;sup&gt;7&lt;/sup&gt;</td>
</tr>
</tbody>
</table>

<sup>6</sup> For small and medium Cisco Expressway-E deployments
<sup>7</sup> For large Cisco Expressway-E deployments

**Important**

- The Cisco Expressway-E administrator currently uses port 80 and therefore, incoming requests from the Cisco Jabber Guest client to Cisco Expressway-E on port 80 must be remapped to port 9980 using a firewall (or similar) in front of Cisco Expressway-E. For the mobile client, using 9980 in call links is not supported; you must use port remapping on your firewall to remap port 80 to port 9980.

- The Cisco Expressway-E administrator currently uses port 443 and therefore, incoming requests from the Cisco Jabber Guest client to Cisco Expressway-E on port 443 must be remapped to port 9443 using a firewall (or similar) in front of Cisco Expressway-E. For the mobile client, using 9443 in call links is not supported; you must use port remapping on your firewall to remap port 443 to port 9443.

Set Domain Used for Links, on page 44
### Table 11: Outbound from Cisco Expressway-C (Private) to Cisco Expressway-E (DMZ)

<table>
<thead>
<tr>
<th>Purpose</th>
<th>Protocol</th>
<th>Cisco Expressway-C (Source)</th>
<th>Cisco Expressway-E (Destination)</th>
</tr>
</thead>
<tbody>
<tr>
<td>SSH (HTTP/S tunnels)</td>
<td>TCP</td>
<td>Ephemeral port</td>
<td>2222 (not configurable)</td>
</tr>
<tr>
<td>Traversal zone SIP signaling</td>
<td>TLS</td>
<td>25000–29999</td>
<td>7001</td>
</tr>
<tr>
<td>Media</td>
<td>UDP</td>
<td>36000–59999</td>
<td>36000–36001&lt;sup&gt;8&lt;/sup&gt;</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>36000–36011&lt;sup&gt;9&lt;/sup&gt;</td>
</tr>
</tbody>
</table>

**Note:** If the internal > DMZ firewall rules allow outgoing traffic, no rules are needed for media.

8. For small and medium Cisco Expressway-E deployments
9. For large Cisco Expressway-E deployments

### Table 12: Outbound from Cisco Jabber Guest (Private) to Cisco Expressway-E (DMZ)

<table>
<thead>
<tr>
<th>Purpose</th>
<th>Protocol</th>
<th>Cisco Jabber Guest (Source)</th>
<th>Cisco Expressway-E (Destination)</th>
</tr>
</thead>
<tbody>
<tr>
<td>SIP</td>
<td>TCP/TLS</td>
<td>Ephemeral port</td>
<td>5060 (SIP over TCP)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>5061 (SIP over TLS)</td>
</tr>
</tbody>
</table>

### Table 13: Inbound from Cisco Expressway-E (DMZ) to Cisco Jabber Guest (Private)

<table>
<thead>
<tr>
<th>Purpose</th>
<th>Protocol</th>
<th>Cisco Expressway-E (Source)</th>
<th>Cisco Jabber Guest (Destination)</th>
</tr>
</thead>
<tbody>
<tr>
<td>SIP</td>
<td>TCP/TLS</td>
<td>Ephemeral port</td>
<td>5060 (SIP over TCP)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>5061 (SIP over TLS)</td>
</tr>
</tbody>
</table>

### Table 14: From Cisco Expressway-C to Cisco Jabber Guest

<table>
<thead>
<tr>
<th>Purpose</th>
<th>Protocol</th>
<th>Cisco Expressway-C (Source)</th>
<th>Cisco Jabber Guest (Destination)</th>
</tr>
</thead>
<tbody>
<tr>
<td>HTTP</td>
<td>TCP</td>
<td>Ephemeral port</td>
<td>80</td>
</tr>
<tr>
<td>HTTPS</td>
<td>TLS</td>
<td>Ephemeral port</td>
<td>443</td>
</tr>
</tbody>
</table>
### Clustering Options

Cisco Jabber Guest only supports a three-server cluster. Three operational servers are required for full redundancy.

**Recommended Deployment**

Configure the reverse proxy to send requests to only one server in the cluster at a time. You set the order in which requests are sent on Cisco Expressway-C, from the **Priority** field in **Configuration > Unified Communications > Configuration > Configure Jabber Guest servers**. Give each Cisco Jabber Guest server a different priority. Requests are sent to a different server only if a server becomes unresponsive.

Cisco Jabber Guest can be administered from any server in the cluster. To simplify troubleshooting, we recommend that you use one server in the cluster for administration purposes.

**Data Replication**

The following table describes which data replicates in a cluster.

#### Table 16: Cluster Data Replication

<table>
<thead>
<tr>
<th>Data That Replicates</th>
<th>Data That Does Not Replicate</th>
</tr>
</thead>
<tbody>
<tr>
<td>Users</td>
<td>Settings &gt; Local SSL Certificate</td>
</tr>
<tr>
<td>Links</td>
<td>Settings &gt; Call Control and Media (Local)</td>
</tr>
<tr>
<td>Services &gt; Passwords</td>
<td>Logs</td>
</tr>
<tr>
<td>Settings &gt; Links</td>
<td></td>
</tr>
<tr>
<td>Settings &gt; Mobile</td>
<td></td>
</tr>
<tr>
<td>Settings &gt; Secure SIP Trust Certificate</td>
<td></td>
</tr>
<tr>
<td>Settings &gt; Call Control and Media</td>
<td></td>
</tr>
</tbody>
</table>

**Cluster Latency**

The upper latency limit is 15 milliseconds.

**Related Topics**

- Cluster, on page 49
Load Balancing Methods Available

You can balance the load on your Cisco Expressway-C, Cisco Expressway-E, and Cisco Jabber Guest server clusters.

The following table describes the methods of load balancing that are available to distribute different types of traffic across the network.

**Table 17: Load Balancing Methods**

<table>
<thead>
<tr>
<th>Network Traffic</th>
<th>Method of Load Balancing Available</th>
</tr>
</thead>
<tbody>
<tr>
<td>SIP for call control</td>
<td>Send SIP to the Cisco Expressway-C server cluster • Round-robin DNS • Round-robin comma-separated values (CSV) • HTTP</td>
</tr>
<tr>
<td></td>
<td>Send SIP to the Cisco Expressway-E server cluster Send SIP to the Cisco Expressway-E server that provided TURN service</td>
</tr>
<tr>
<td>TURN credential provisioning requests to the Cisco Expressway-C server cluster</td>
<td>• Round-robin DNS • Round-robin CSV • HTTP</td>
</tr>
<tr>
<td>HTTPS from the Cisco Jabber Guest client to the Cisco Expressway-E server cluster</td>
<td>Round-robin DNS</td>
</tr>
<tr>
<td>TURN for media between the Cisco Jabber Guest client and the Cisco Expressway-E server cluster</td>
<td>• Round-robin DNS for the Cisco Expressway-E server IP address and port range for round-robin TURN port range • Round-robin CSV for the Cisco Expressway-E server IP address and port range for round-robin TURN port range</td>
</tr>
<tr>
<td>HTTP between the Cisco Expressway-E and Cisco Jabber Guest server clusters</td>
<td>Configure Cisco Jabber Guest server priorities on the Cisco Expressway-C server.</td>
</tr>
</tbody>
</table>

**Important** For a clustered Cisco Expressway-E with dual NIC deployment, you must send SIP to the Cisco Expressway-E server that provided TURN service.

**Important** TURN port ranges are only supported when you use the large Cisco Expressway-E virtual machine.
Related Topics

- Round-Robin DNS Load Balancing
- Configure Round-Robin CSV Loading Balancing, on page 56
- Configure HTTP Load Balancing, on page 57
- Configure Round-Robin TURN Port Range Load Balancing, on page 57
Install Cisco Jabber Guest Server

Overview

Cisco Jabber Guest is deployed as a virtual server and requires a VMware server to act its host. The server operating system is CentOS. Cisco Jabber Guest is an on-premises deployment: all services are set up, managed, and maintained on your corporate network.

Cisco Jabber Guest is delivered as an OVA image and deployed manually.

For a summary of the Cisco Unified Communications Manager to Cisco Expressway configuration, see the Cisco Unified Communications Manager/Cisco Expressway Configuration Checklist.

Related Topics

Cisco Unified Communications Manager/Cisco Expressway Configuration Checklist, on page 72

Install Server

Do one of the following:

• Install Server to vCenter Server, on page 24
• Install Server to ESXi, UC Virtualization Foundation, or UC Virtualization Hypervisor, on page 25
## Install Server to vCenter Server

**Procedure**

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Download JabberGuest-11.x.x.x-New-Install.iso or access the file from the physical media you receive.</td>
</tr>
<tr>
<td>Step 2</td>
<td>Extract the contents from the ISO file.</td>
</tr>
<tr>
<td>Step 3</td>
<td>Copy the .OVA to a location on your drive that is accessible to vSphere.</td>
</tr>
<tr>
<td>Step 4</td>
<td>Open the vSphere Client.</td>
</tr>
<tr>
<td>Step 5</td>
<td>Choose File &gt; Deploy OVF Template.</td>
</tr>
<tr>
<td>Step 6</td>
<td>In the Source screen, browse to location of the OVA package, and then click Next. You can enter the URL if you know it.</td>
</tr>
<tr>
<td>Step 7</td>
<td>Verify the details in the OVF Template Details screen, and then click Next.</td>
</tr>
<tr>
<td>Step 8</td>
<td>In the Name and Location screen, enter a name for the virtual machine, select its location, and then click Next.</td>
</tr>
<tr>
<td>Step 9</td>
<td>In the Host / Cluster screen, select the virtual machine deployment cluster, and then click Next.</td>
</tr>
<tr>
<td>Step 10</td>
<td>In the Storage screen, select the virtual machine storage usage, and then click Next.</td>
</tr>
<tr>
<td>Step 11</td>
<td>In the Disk Format screen, select a Virtual Machine Disk (VMDK) provisioning format, and then click Next.</td>
</tr>
<tr>
<td>Step 12</td>
<td>In the Networking Mapping screen, select the appropriate Destination Networks for OVA deployment, and then click Next.</td>
</tr>
<tr>
<td>Step 13</td>
<td>In the Properties screen, enter the network settings, and then click Next. The virtual machine is set up with DHCP by default. Provide the following to configure the virtual machine with a static IP address:</td>
</tr>
<tr>
<td></td>
<td>• IP address</td>
</tr>
<tr>
<td></td>
<td>• Network mask</td>
</tr>
<tr>
<td></td>
<td>• Hostname</td>
</tr>
<tr>
<td></td>
<td>• Gateway IP address</td>
</tr>
<tr>
<td></td>
<td>• At least one DNS server IP address</td>
</tr>
</tbody>
</table>

**Important** Do not add leading zeros to the IP addresses. The addresses won't resolve as intended.

| Step 14 | Click Finish. |

**What to do next**

To turn on the virtual machine after it has been created, in the console window select **Power On**.

Configure the appropriate SIP trunk in Cisco Unified Communications Manager or zones in Cisco TelePresence Video Communication Server depending on the type of server deployed in your network.
If the virtual machine cannot acquire the IP address of your VLAN, it shows a bootup failure related to network eth0.

Install Server to ESXi, UC Virtualization Foundation, or UC Virtualization Hypervisor

Procedure

Step 1  Download JabberGuest-11.x.x.x-New-Install.iso or access the file from the physical media you receive.
Step 2  Extract the contents from the ISO file.
Step 3  Copy the .OVA to a location on your drive that is accessible to vsphere.
Step 4  Open the vsphere Client.
Step 5  Choose File > Deploy OVF Template.
Step 6  In the Source screen, browse to location of the OVA package, and then click Next.
        You can enter the URL if you know it.
Step 7  Verify the details in the OVF Template Details screen, and then click Next.
Step 8  In the Name and Location screen, enter a name for the virtual machine, select its location, and then click Next.
Step 9  In the Disk Format screen, select a Virtual Machine Disk (VMDK) provisioning format, and then click Next.
Step 10 Click Finish.

What to do next

To turn on the virtual machine after it has been created, in the console window, select Power On.

The virtual machine is set up with DHCP by default. If you want to configure the virtual machine with a static IP address, edit the following properties in network configuration file: IP address, network mask, hostname, gateway IP address, and at least one DNS server IP address. ESXi 6.5 provides properties screen to set up static IP address directly, and it might not work with the current release.

Configure the appropriate SIP trunk in Cisco Unified Communications Manager or zones in Cisco TelePresence Video Communication Server depending on the type of server deployed in your network.

If the virtual machine cannot acquire the IP address of your VLAN, it shows a boot up failure related to network eth0.
Sign In to Cisco Jabber Guest Administration

The Cisco Jabber Guest server is set up with default credentials.

Before you begin

You can access Cisco Jabber Guest Administration on Windows with:

- Google Chrome 18 or later
- Microsoft Internet Explorer 8 or later (32-bit, or 64-bit running 32-bit tabs only)
- Mozilla Firefox 10 or later

You can access Cisco Jabber Guest Administration on Mac with:

- Safari 7 to 11
- Google Chrome 18 or later
- Mozilla Firefox 10 or later

Your session times out after 30 minutes of inactivity.

Procedure

Step 1
From a compatible browser, navigate to the IP address or host name of your Cisco Jabber Guest server and append /admin/ to the URL.

Step 2
For **Alias**, enter *admin*.

Step 3
For **Password**, enter *jabbercserver*.

The first time that you sign in you must change your password.

Step 4
Enter a new password.

Install Certificate

When you install Cisco Jabber Guest, a self-signed certificate is installed by default. If you want, you can:

- Install a certificate that is signed by a third party (a trusted certificate authority).
- Install a certificate with additional distinguished name information.
- Install a certificate that includes the intermediate certificate or the entire certificate trust chain.

Cisco Jabber Guest supports installing DER encoded certificates and PEM encoded certificates.
The certificate signing request must be generated on the server on which you install the certificate. For this reason, we recommend that you obtain a new CA-signed certificate for your new install of Cisco Jabber Guest or use a self-signed certificate.

If you choose to use the certificate that is installed by default, you must generate a new self-signed certificate if the hostname of the server changes.

Install Certificate Signed by a Certificate Authority

The following procedure creates a certificate signing request in which the Distinguished Name (DN) information is composed of Common Name=<ip address> only. If your organization requires you to include additional DN information in your request, follow the instructions in the procedure, Install Certificate with Additional Distinguished Name Information.

If you have deployed a Cisco Jabber Guest cluster, you must install a certificate on each server in the cluster. When you create the new certificate signing request, the current certificate becomes invalid.

Procedure

**Step 1**  Sign in to Cisco Jabber Guest Administration as an administrator.
**Step 2**  Click **Settings**, and then click **Local SSL Certificate**.
**Step 3**  Under **Certificate Signing Request Options**, click **Create a New Certificate Signing Request**.
**Step 4**  Click **Download a certificate signing request**.
A 4096-bit certificate signing request named **csr.pem** downloads.
**Step 5**  Send the certificate signing request to a trusted certificate authority.
**Step 6**  After you receive the signed certificate from the certificate authority:
   a) Click **Choose File**.
   b) Open the signed certificate.
   c) Click **Install a Certificate Authority Signed Certificate**.
   Under **Certificate Status**, the following message appears:
   **This system has a certificate authority signed certificate**
   **Step 7**  Restart the virtual machine:
   a) Open vSphere Client.
   b) In the virtual machines and templates inventory tree, right-click the virtual machine.
   c) Choose **Power > Restart Guest**.

Related Topics

Install Certificate with Additional Distinguished Name Information, on page 28
Install Certificate with Additional Distinguished Name Information

If you use Cisco Jabber Guest Administration to create a certificate signing request, the Distinguished Name (DN) information in the request is composed only of Common Name=<ip address>. If your organization requires you to include additional DN information, such as organization name and locality name, use the following procedure.

If you have deployed a Cisco Jabber Guest cluster, you must install a certificate on each server in the cluster. When you create the new certificate signing request, the current certificate becomes invalid.

**Procedure**

**Step 1** Sign in to the server as root.
**Step 2** Change directory to /opt/cisco/webcommon/scripts:

```bash
/opt/cisco/webcommon/scripts
```
**Step 3** Execute the `createcsr` script:

```bash
./createcsr.sh
```
**Step 4** Follow the instructions on the screen to enter additional DN information, including country name, state or province name, locality name, organization name, organizational unit name, and common name. After you enter the information, the `csr` file is saved in a location from which you download it in Step 7.
**Step 5** Sign in to Cisco Jabber Guest Administration as an administrator.
**Step 6** Click **Settings**, and then click **Local SSL Certificate**.
**Step 7** Under **Certificate Signing Request Options**, click **Download a certificate signing request**. A 4096-bit certificate signing request named `csr.pem` downloads.
**Step 8** Send the certificate signing request to a trusted certificate authority.
**Step 9** After you receive the signed certificate from the certificate authority:
   a) Click **Choose File**.
   b) Open the signed certificate.
   c) Click **Install a Certificate Authority Signed Certificate**.
      Under **Certificate Status**, the following message appears:

      This system has a certificate authority signed certificate

**Step 10** Restart the virtual machine:
   a) Open vSphere Client.
   b) In the virtual machines and templates inventory tree, right-click the virtual machine.
   c) Choose **Power > Restart Guest**.
Install Certificate That Includes the Intermediate Certificate or the Entire Certificate Trust Chain

You can upload a combined certificate file that includes the Cisco Jabber Guest server certificate and your intermediate certificate or that includes the Cisco Jabber Guest server certificate, your intermediate certificate, and your root certificate.

If you have deployed a Cisco Jabber Guest cluster, you must install a certificate on each server in the cluster. When you create the new certificate signing request, the current certificate becomes invalid.

Procedure

Step 1
Sign in to Cisco Jabber Guest Administration as an administrator.

Step 2
Click Settings, and then click Local SSL Certificate.

Step 3
Under Certificate Signing Request Options, click Create a New Certificate Signing Request.

Step 4
Click Download a certificate signing request. A 4096-bit certificate signing request named csr.pem downloads.

Step 5
Send the certificate signing request to a trusted certificate authority.

Step 6
After you receive the signed certificate from the certificate authority, open it in a text editor, such as Notepad.

Step 7
Download your intermediate certificate.

Step 8
In the Cisco Jabber Guest certificate, after "-----END CERTIFICATE-----", paste the entire body of your intermediate certificate.

Note
Make sure that you include the beginning and end tags of both certificates. The result should look like this:

```
----BEGIN CERTIFICATE-----
(Cisco Jabber Guest certificate)
-----END CERTIFICATE-----
-----BEGIN CERTIFICATE-----
(Your intermediate certificate)
-----END CERTIFICATE-----
```

Step 9
(Optional) If you want to include the root certificate in the combined certificate file:

a) Download your root certificate.

b) In the Cisco Jabber Guest certificate, after "-----END CERTIFICATE-----" for the intermediate file, paste the entire body of your root certificate.

Note
Make sure that you include the beginning and end tags of all three certificates. The result should look like this:

```
----BEGIN CERTIFICATE-----
(Cisco Jabber Guest certificate)
-----END CERTIFICATE-----
-----BEGIN CERTIFICATE-----
(Your intermediate certificate)
-----END CERTIFICATE-----
-----BEGIN CERTIFICATE-----
(Your root certificate)
-----END CERTIFICATE-----
```
Step 10 Make sure that there is no additional formatting in the file.
Step 11 Save the combined certificate file.
Step 12 Sign in to Cisco Jabber Guest Administration as an administrator.
Step 13 Click Settings, and then click Local SSL Certificate.
Step 14 Click Choose File, open the combined certificate file, and click Install a Certificate Authority Signed Certificate.
Under Certificate Status, the following message appears:
This system has a certificate authority signed certificate
Step 15 Restart the virtual machine:
a) Open vSphere Client.
b) In the virtual machines and templates inventory tree, right-click the virtual machine.
c) Choose Power > Restart Guest.

Edit the Certificate Trust Chain

If you make a mistake adding the certificate trust chain, use the following procedure to replace the existing certificate.

Procedure

Step 1 Sign in to Cisco Jabber Guest Server command-line interface.
Step 2 Change directory to /etc/opt/cisco/webcommon/security/ssl:
/etc/opt/cisco/webcommon/security/ssl
Step 3 Create an empty file named server.csr:
touch server.csr
Step 4 Change directory to /etc/opt/cisco/webcommon/.security/ssl:
/etc/opt/cisco/webcommon/.security/ssl
Step 5 Copy server.pem and rename new_server.pem:
cp server.pem new_server.pem
Step 6 In the Cisco Jabber Guest certificate, after ------END CERTIFICATE------, paste the entire body of your intermediate certificate.

Note Make sure that you include the beginning and end tags of both certificates. The result should look like this:

-----BEGIN CERTIFICATE-----
(Cisco Jabber Guest certificate)
-----END CERTIFICATE-----

-----BEGIN CERTIFICATE-----
(Your intermediate certificate)
-----END CERTIFICATE-----

Step 7 (Optional) If you want to include the root certificate in the combined certificate file:
a) Download your root certificate.
b) In the Cisco Jabber Guest certificate, after -----END CERTIFICATE----- for the intermediate file, paste the entire body of your root certificate.

**Note** Make sure that you include the beginning and end tags of all three certificates. The result should look like this:

```
----BEGIN CERTIFICATE-----
(Cisco Jabber Guest certificate)
-----END CERTIFICATE-----
-----BEGIN CERTIFICATE-----
(Your intermediate certificate)
-----END CERTIFICATE-----
-----BEGIN CERTIFICATE-----
(Your root certificate)
-----END CERTIFICATE-----
```

**Step 8** Make sure that there is no additional formatting in the file.
**Step 9** Save the combined certificate file.
**Step 10** Sign in to Cisco Jabber Guest Administration as an administrator.
**Step 11** Click **Settings**, and then click **Local SSL Certificate**.
**Step 12** Click **Choose File**, open the combined certificate file, and click **Install a Certificate Authority Signed Certificate**.

Under **Certificate Status**, the following message appears:

This system has a certificate authority signed certificate

**Step 13** Restart the virtual machine:
a) Open vSphere Client.
b) In the virtual machines and templates inventory tree, right-click the virtual machine.
c) Choose **Power > Restart Guest**.

---

**Generate New Self-Signed Certificate**

If you are using the self-signed certificate that is installed by default and the hostname of the server changes, you must generate a new self-signed certificate.

When you generate a new self-signed certificate, the current certificate becomes invalid.

**Procedure**

**Step 1** Sign in to Cisco Jabber Guest Administration as an administrator.
**Step 2** Click **Settings**, and then click **Local SSL Certificate**.
**Step 3** Click **Generate a New Self-Signed Certificate**.
The message **Update successful** appears.
**Step 4** Restart the virtual machine:
a) Open vSphere Client.
b) In the virtual machines and templates inventory tree, right-click the virtual machine.
c) Choose Power > Restart Guest.

## Sign In to Cisco Jabber Guest Server CLI

The Cisco Jabber Guest server command-line interface (CLI) is set up with default credentials.

**Procedure**

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>For the user ID, enter root.</td>
</tr>
<tr>
<td>Step 2</td>
<td>For the password enter jabbercserver. The first time that you sign in, you must change the password.</td>
</tr>
<tr>
<td>Step 3</td>
<td>Enter a new password.</td>
</tr>
</tbody>
</table>

## Change Time Zone on Server

By default, the server time zone is set to Coordinated Universal Time (UTC). To change the time zone, use the following procedure.

The time zone change takes effect immediately.

**Procedure**

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Sign in to the server as root.</td>
</tr>
<tr>
<td>Step 2</td>
<td>Check the current time zone by executing the command: date. The date and time appear in the format: ddd mmm dd hh:mm:ss UTC yyyy. For example: Fri Dec 20 16:57:18 UTC 2013.</td>
</tr>
<tr>
<td>Step 3</td>
<td>Change directory to /opt/cisco/webcommon/scripts: cd /opt/cisco/webcommon/scripts</td>
</tr>
<tr>
<td>Step 4</td>
<td>Execute the timezone script: ./timezone</td>
</tr>
<tr>
<td>Step 5</td>
<td>Follow the on-screen instructions.</td>
</tr>
<tr>
<td>Step 6</td>
<td>At the confirmation message, type 1 for Yes.</td>
</tr>
<tr>
<td>Step 7</td>
<td>Verify that the server is set to your time zone by executing the command: date.</td>
</tr>
<tr>
<td>Step 8</td>
<td>Restart Tomcat: service tomcat-as-standalone.sh restart</td>
</tr>
</tbody>
</table>
Perform Initial Setup

- Configure Cisco Expressway-E and Cisco Expressway-C, on page 33
- Change MTU Size, on page 38
- Configure Signaling and Media, on page 39
- Configure Static NAT Mode on Cisco Expressway-E, on page 41
- Configure TURN Credential Provisioning, on page 42
- Set Up TURN Server Information, on page 42
- Set FQDN of Cisco Jabber Guest Server, on page 43
- Set Domain Used for Links, on page 44
- Customize Cisco Jabber Guest Clients, on page 44

Configure Cisco Expressway-E and Cisco Expressway-C

Do one of the following:

- Configure Cisco Expressway-E and Cisco Expressway-C: Cisco Expressway-E with Single NIC Deployment, on page 33
- Configure Cisco Expressway-E and Cisco Expressway-C: Cisco Expressway-E with Dual NIC Deployment, on page 36

Configure Cisco Expressway-E and Cisco Expressway-C: Cisco Expressway-E with Single NIC Deployment

Cisco Expressway-E and Cisco Expressway-C provide the following functionality:

- Both provide reverse proxy for HTTPS traffic.
- Cisco Expressway-E provides TURN relays.
- Cisco Expressway-C routes calls to Cisco Unified Communications Manager through a SIP trunk.
**Before you begin**

Follow the instructions in the Cisco Expressway documentation to set up Cisco Expressway security certificates and a Unified Communications traversal zone. Configure the traversal zone type between the Cisco Expressway-C and Cisco Expressway-E as *Unified Communications traversal*.

**Procedure**

<table>
<thead>
<tr>
<th>Step 1</th>
<th>On the Cisco Expressway-E, enable Cisco Jabber Guest support:</th>
</tr>
</thead>
<tbody>
<tr>
<td>a)</td>
<td>Choose <strong>Configuration &gt; Unified Communications &gt; Configuration.</strong></td>
</tr>
<tr>
<td>b)</td>
<td>From the <strong>Unified Communications mode</strong> drop-down list, select <strong>Jabber Guest services.</strong></td>
</tr>
<tr>
<td>c)</td>
<td>Click <strong>Save.</strong></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Step 2</th>
<th>On the Cisco Expressway-E, enable TURN service:</th>
</tr>
</thead>
<tbody>
<tr>
<td>a)</td>
<td>Choose <strong>Configuration &gt; Traversal &gt; TURN.</strong></td>
</tr>
<tr>
<td>b)</td>
<td>From the <strong>TURN services</strong> drop-down list, select <strong>On.</strong></td>
</tr>
<tr>
<td>c)</td>
<td>Click <strong>Save.</strong></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Step 3</th>
<th>On the Cisco Expressway-C, enable Cisco Jabber Guest support:</th>
</tr>
</thead>
<tbody>
<tr>
<td>a)</td>
<td>Choose <strong>Configuration &gt; Unified Communications &gt; Configuration.</strong></td>
</tr>
<tr>
<td>b)</td>
<td>From the <strong>Unified Communications mode</strong> drop-down list, select <strong>Jabber Guest services.</strong></td>
</tr>
<tr>
<td>c)</td>
<td>Click <strong>Save.</strong></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Step 4</th>
<th>On the Cisco Expressway-C, configure the domain for which HTTP traffic will be routed to the Cisco Jabber Guest server:</th>
</tr>
</thead>
<tbody>
<tr>
<td>a)</td>
<td>Choose <strong>Configuration &gt; Domains.</strong></td>
</tr>
<tr>
<td>b)</td>
<td>Create a new domain if none exist or, in the row of the target domain, click <strong>View/Edit.</strong></td>
</tr>
<tr>
<td>c)</td>
<td>From the <strong>Jabber Guest</strong> drop-down list, select <strong>On.</strong></td>
</tr>
<tr>
<td>d)</td>
<td>Click <strong>Save.</strong></td>
</tr>
<tr>
<td>e)</td>
<td>Repeat Step 5.a. through Step 5.d. for each domain.</td>
</tr>
</tbody>
</table>

| Step 5 | Make sure that the domain has an associated DNS record that resolves to the Cisco Expressway-E. The domain information is propagated from the Cisco Expressway-C to the Cisco Expressway-E through the SSH tunnel (port 2222). It is used by the Cisco Expressway-E to validate incoming HTTP requests for the Cisco Jabber Guest service. |

<table>
<thead>
<tr>
<th>Step 6</th>
<th>On the Cisco Expressway-C, associate the Cisco Jabber Guest servers with the domain:</th>
</tr>
</thead>
<tbody>
<tr>
<td>a)</td>
<td>Choose <strong>Configuration &gt; Unified Communications &gt; Configuration.</strong></td>
</tr>
<tr>
<td>b)</td>
<td>In the <strong>Advanced</strong> section, click <strong>Configure Jabber Guest servers.</strong></td>
</tr>
<tr>
<td>c)</td>
<td>Click <strong>New.</strong></td>
</tr>
<tr>
<td>d)</td>
<td>For <strong>Server hostname</strong>, enter the FQDN of the Cisco Jabber Guest server.</td>
</tr>
<tr>
<td>e)</td>
<td>For <strong>Priority</strong>, enter the priority of the Cisco Jabber Guest server. Lower numbers have higher priority.</td>
</tr>
<tr>
<td>f)</td>
<td>Make sure that all Cisco Jabber Guest servers have a different priority so that calls are only sent to one Cisco Jabber Guest server in the deployment at a time.</td>
</tr>
<tr>
<td>g)</td>
<td>From the <strong>Domain</strong> drop-down list, select the Cisco Jabber Guest HTTP domain.</td>
</tr>
<tr>
<td>h)</td>
<td>Click <strong>Create entry.</strong></td>
</tr>
</tbody>
</table>
h) Repeat Step 6.c. through Step 6.g. for each Cisco Jabber Guest server in the cluster.

**Step 7**

 Verify that the SSH tunnel is active:

a) On either the Cisco Expressway-C or the Cisco Expressway-E, choose **Status > Unified Communications**.

b) Click **View ssh tunnel status**.

c) Make sure that the Cisco Jabber Guest domain is listed and that the SSH tunnel is active.

**Step 8**

 On the Cisco Expressway-C, create a neighbor zone for each Cisco Jabber Guest server:

a) Choose **Configuration > Zones > Zones**.

b) Click **New**.

c) Enter the details. From the **Type** drop-down list, select **Neighbor**.

d) In the **H.323** section, from the **Mode** drop-down list, select **Off**

e) In the **SIP** section, from the **Mode** drop-down list, select **On**.

f) For **Port**, enter **5061**.

g) From the **Transport** drop-down list, select **TLS**.

**Note** To enable TLS, you must also upload the Cisco Expressway-C certificate to Cisco Jabber Guest Administration. For more information, see Configure Signaling and Media: Cisco Expressway-E with Single NIC Deployment, on page 39.

h) From the **Media encryption mode** drop-down list, select **Best effort**.

**Important** Selecting **Best effort** forces media from the Cisco Expressway-E to terminate on the Cisco Expressway-C.

i) From the **ICE support** drop-down list, select **Off**.

j) In the **Location** section, for **Peer 1 address**, enter the IP address or FQDN of the Cisco Jabber Guest server.

k) In the **Advanced** section, from the **Zone profile** drop-down list, select **Default**.

l) Click **Create zone**.

m) Repeat Step 7.b. through 7.l. for each Cisco Jabber Guest server in a Cisco Jabber Guest cluster.

Do not configure any search rules for these neighbor zones. These zones are used to receive traffic only.

**Step 9**

 Set up a connection between the Cisco Expressway-C and Cisco Unified Communications Manager:

a) On Cisco Unified Communications Manager, set up a non-secure or secure SIP trunk and point it to the Cisco Expressway-C.

b) On Cisco Expressway-C, set up a neighbor zone and point it to Cisco Unified Communications Manager.

Follow the steps in the *Cisco Unified Communications Manager with Cisco Expressway (SIP Trunk) Deployment Guide*.

**Step 10**

 Create a search rule on Cisco Expressway-C to route calls to Cisco Unified Communications Manager.

**Step 11**

 Force the protocol between the Cisco Jabber Guest server and the Cisco Expressway-C to be http:

a) Sign in to the Cisco Expressway-C command-line interface as an administrator. In a clustered Cisco Expressway-C deployment, sign in to the master Cisco Expressway-C.

b) Enter the following command:

```
xconf CollaborationEdge JabbercProxyProtocol: http
```

HTTP request goes from the Cisco Expressway-E to the Cisco Expressway-C to the Cisco Jabber Guest server.
Configure Cisco Expressway-E and Cisco Expressway-C: Cisco Expressway-E with Dual NIC Deployment

Cisco Expressway-E and Cisco Expressway-C provide the following functionality:

- Both provide reverse proxy for HTTPS traffic.
- Cisco Expressway-E provides TURN relays.
- Cisco Expressway-C routes calls to Cisco Unified Communications Manager through a SIP trunk.

Before you begin

Follow the instructions in the Cisco Expressway documentation to set up Cisco Expressway security certificates and a Unified Communications traversal zone. Configure the traversal zone type between the Cisco Expressway-C and Cisco Expressway-E as *Unified Communications traversal*.

Procedure

| Step 1 | On the Cisco Expressway-E, enable Cisco Jabber Guest support:
|        | a) Choose *Configuration > Unified Communications > Configuration*.
|        | b) From the *Unified Communications mode* drop-down list, select *Jabber Guest services*.
|        | c) Click *Save*.

| Step 2 | On the Cisco Expressway-E, enable TURN service:
|        | a) Choose *Configuration > Traversal > TURN*.
|        | b) From the *TURN services* drop-down list, select *On*.
|        | c) Click *Save*.

| Step 3 | On the Cisco Expressway-C, enable Cisco Jabber Guest support:
|        | a) Choose *Configuration > Unified Communications > Configuration*.
|        | b) From the *Unified Communications mode* drop-down list, select *Jabber Guest services*.
|        | c) Click *Save*.

| Step 4 | On the Cisco Expressway-C, configure the domain for which HTTP traffic routes to the Cisco Jabber Guest server:
|        | This domain is the outward-facing domain that is used to route the call on the Internet when users click a link.
|        | a) Choose *Configuration > Domains*.
|        | b) Create a new domain if none exist or, in the row of the target domain, click *View/Edit*.
|        | c) From the *Jabber Guest* drop-down list, select *On*.
|        | d) Click *Save*.
|        | e) Repeat Step 5.a. through Step 5.d. for each domain.

| Step 5 | Make sure that the domain has an associated DNS record that resolves to the Cisco Expressway-E. The domain information is propagated from the Cisco Expressway-C to the Cisco Expressway-E through the SSH tunnel
(port 2222). The information is used by the Cisco Expressway-E to validate incoming HTTP requests for the Cisco Jabber Guest service.

**Step 6**

On the Cisco Expressway-C, associate the Cisco Jabber Guest servers with the domain:

This allows the Cisco Expressway-C to route HTTP requests with this domain to the appropriate Cisco Jabber Guest server.

a) Choose **Configuration > Unified Communications > Configuration**.
b) In the **Advanced** section, click **Configure Jabber Guest servers**.
c) Click **New**.
d) For **Server hostname**, enter the FQDN of the Cisco Jabber Guest server.
e) For **Priority**, enter the priority of the Cisco Jabber Guest server. Lower numbers have higher priority.

   Give each Cisco Jabber Guest server a different priority so that calls are only sent to one Cisco Jabber Guest server in the deployment at a time.

f) From the **Domain** drop-down list, select the Cisco Jabber Guest HTTP domain.
g) Click **Create entry**.
h) Repeat Step 6.c. through Step 6.g. for each Cisco Jabber Guest server in the cluster.

**Step 7**

Verify that the SSH tunnel is active:

a) On either the Cisco Expressway-C or the Cisco Expressway-E, choose **Status > Unified Communications**.
b) Click **View ssh tunnel status**.
c) Make sure that the Cisco Jabber Guest domain is listed and that the SSH tunnel is active.

**Step 8**

On the Cisco Expressway-E, create a neighbor zone for each Cisco Jabber Guest server so that you can verify that the zone between the Cisco Expressway-E and the Cisco Jabber Guest server is active:

a) Choose **Configuration > Zones > Zones**.
b) Click **New**.
c) Enter the details. From the **Type** drop-down list, select **Neighbor**.
d) In the **H.323** section, from the **Mode** drop-down list, select **Off**
e) In the **SIP** section, from the **Mode** drop-down list, select **On**.
f) For **Port**, enter **5061**.
g) From the **Transport** drop-down list, select **TLS**.

   **Note** To enable TLS, you must also upload the Cisco Expressway-C certificate to Cisco Jabber Guest Administration. For more information, see **Configure Signaling and Media: Cisco Expressway-E with Dual NIC Deployment**, on page 40.

   h) From the **Media encryption mode** drop-down list, select **Best effort**.
i) From the **ICE support** drop-down list, select **Off**.
j) In the **Location** section, for **Peer 1 address**, enter the IP address or FQDN of the Cisco Jabber Guest server.
k) In the **Advanced** section, from the **Zone profile** drop-down list, select **Default**.
l) Click **Create zone**.
m) Repeat Step 7.b. through 7.l. for each Cisco Jabber Guest server in a Cisco Jabber Guest cluster.

   Do not configure any search rules for these neighbor zones. These zones are used to receive traffic only.

**Step 9**

Create a search rule for the traversal zone between the Cisco Expressway-E and the Cisco Expressway-C servers.
Important For proper call routing, the SIP domain that you specify (click **Settings**, click **Call Control and Media**) and the domain that you optionally specify for **Destination** when you create a link (click **Links**, click **New**) must be configured on the Cisco Expressway-E search rule to point to the traversal zone.

**Step 10**
Set up a connection between the Cisco Expressway-C and Cisco Unified Communications Manager:

a) On Cisco Unified Communications Manager, set up a non-secure or secure SIP trunk and point it to the Cisco Expressway-C.
b) On Cisco Expressway-C, set up a neighbor zone and point it to Cisco Unified Communications Manager.

Follow the steps in the *Cisco Unified Communications Manager with Cisco Expressway (SIP Trunk) Deployment Guide*.

**Step 11**
Create a search rule on Cisco Expressway-C to route calls to Cisco Unified Communications Manager.

**Step 12**
Force the protocol between the Cisco Jabber Guest server and the Cisco Expressway-C to be http:

a) Sign in to the Cisco Expressway-C command-line interface as an administrator. In a clustered Cisco Expressway-C deployment, you must sign in to the master Cisco Expressway-C.
b) Enter the following command:

```
xconf CollaborationEdge JabbercProxyProtocol: http
```

HTTP request goes from the Cisco Expressway-E to the Cisco Expressway-C to the Cisco Jabber Guest server.

**Related Topics**

- Cisco Expressway Series on www.cisco.com
- Cisco Unified Communications Manager with Cisco Expressway (SIP Trunk) Deployment Guide

### Change MTU Size

In some call scenarios, such as when using VPN, the default Maximum Transmission Unit (MTU) on Cisco Expressway-E is too high and can cause packet loss. The default MTU is 1500 bytes. We recommend that you lower the MTU to 1400 bytes. If you do not, callers may experience problems, such as one-way video.

**Procedure**

**Step 1**
On Cisco Expressway-E, do one of the following:

- If you have Cisco Expressway-E X8.2, choose **System > IP**.
- If you have Cisco Expressway-E X8.5 or later, choose **System > Network Interfaces > IP**.

**Step 2**
In the **LAN 1** section, for **Maximum transmission unit (MTU)**, enter **1400**.

**Step 3**
Click **Save**.
Configure Signaling and Media

Do one of the following:

- Configure Signaling and Media: Cisco Expressway-E with Single NIC Deployment, on page 39
- Configure Signaling and Media: Cisco Expressway-E with Dual NIC Deployment, on page 40

Related Topics
Check BFCP Settings for Screen Sharing, on page 65

Configure Signaling and Media: Cisco Expressway-E with Single NIC Deployment

We recommend enabling Session Initiation Protocol (SIP) over Transport Layer Security (TLS) for call control signaling and enabling Secure Real-Time Transfer Protocol (SRTP) for secure media. Secure media requires secure signaling.

Before you begin
On Cisco Expressway-C, make sure that you have created a neighbor zone for each Cisco Jabber Guest server. For more information, see Configure Cisco Expressway-E and Cisco Expressway-C: Cisco Expressway-E with Single NIC Deployment, on page 33.

Procedure

Step 1
To enable SIP over TLS, obtain the Cisco Expressway-C server certificate or the Cisco Expressway-C certificate authority certificate:

- If you have a single Cisco Expressway-C, obtain the Cisco Expressway-C server certificate.
- If Cisco Expressway-C is a cluster of servers, obtain the Cisco Expressway-C certificate authority certificate. This certificate must be uploaded to the Cisco Jabber Guest server so that Cisco Jabber Guest can communicate with all nodes in the Cisco Expressway-C cluster.

Step 2
Upload the certificate to Cisco Jabber Guest Administration:

a) Sign in to Cisco Jabber Guest Administration as an administrator.
b) Click Settings, and then click Secure SIP Trust Certificate.
c) Under Secure SIP Trust Certificate, click Choose File.
d) Select the certificate that you obtained, and then click Upload.

Step 3
Configure the Call Control and Media settings in Cisco Jabber Guest Administration:

a) Click Call Control and Media.
b) Select Route calls using Cisco Expressway.
c) Check Enable SIP over TLS.
d) Check Enable SRTP.
e) For SIP port, enter 5061.
f) For **SIP domain**, enter the SIP domain. This setting is used if the Cisco Jabber Guest link does not contain a SIP domain. In most cases, this is the enterprise SIP domain as configured in Cisco Unified Communications Manager.
g) For **SIP server**, enter the IP address or FQDN of the Cisco Expressway-C.
h) Specify whether SIP is sent to the Cisco Expressway-C that originated the HTTP call control or to the server entered above.

**Step 4**  
Click **Update**.  
The message **Update successful** appears.

**Step 5**  
Restart Tomcat:  
```
service tomcat-as-standalone.sh restart
```

**Step 6**  
On the Cisco Expressway-C, verify that the neighbor zones for each Cisco Jabber Guest server are active:  
a) Choose **Configuration > Zones > Zones**.  
b) View the **SIP status** column.

---

**Configure Signaling and Media: Cisco Expressway-E with Dual NIC Deployment**

We recommend enabling Session Initiation Protocol (SIP) over Transport Layer Security (TLS) for call control signaling and enabling Secure Real-Time Transfer Protocol (SRTP) for secure media. Secure media requires secure signaling.

**Before you begin**

On Cisco Expressway-E, make sure that you have created a neighbor zone for each Cisco Jabber Guest server. For more information, see Configure Cisco Expressway-E and Cisco Expressway-C: Cisco Expressway-E with Dual NIC Deployment, on page 36.

**Procedure**

**Step 1**  
To enable SIP over TLS, obtain the Cisco Expressway-E server certificate or the Cisco Expressway-E certificate authority certificate:  

- If you have a single Cisco Expressway-E, obtain the Cisco Expressway-E server certificate.  
- If Cisco Expressway-E is a cluster of servers, obtain the Cisco Expressway-E certificate authority certificate. This certificate must be uploaded to the Cisco Jabber Guest server so that Cisco Jabber Guest can communicate with all nodes in the Cisco Expressway-E cluster.

**Step 2**  
Upload the certificate to Cisco Jabber Guest Administration:  
a) Sign in to Cisco Jabber Guest Administration as an administrator.  
b) Click **Settings**, and then click **Secure SIP Trust Certificate**.  
c) Under **Secure SIP Trust Certificate**, click **Choose File**.  
d) Select the certificate that you obtained, and then click **Upload**.

**Step 3**  
Configure the **Call Control and Media** settings in Cisco Jabber Guest Administration:  
a) Click **Call Control and Media**.  
b) Select **Route calls using Cisco Expressway**.
c) Check **Enable SIP over TLS**.

d) Check **Enable SRTP**.

e) For **SIP port**, enter **5061**.

f) For **SIP domain**, enter the SIP domain. This setting is used if the Cisco Jabber Guest link does not contain a SIP domain. In most cases, this is the enterprise SIP domain as configured in Cisco Unified Communications Manager.

  **Important** For proper call routing, the SIP domain must be configured on the Cisco Expressway-E search rule to point to the traversal zone.

g) For a single Cisco Expressway-E server, for **SIP server**, enter the IP address or FQDN of Cisco Expressway-E's internal NIC.

h) Select where to send SIP traffic:

   - For a single Cisco Expressway-E server, select **SIP server specified above**.
   - For cluster of Cisco Expressway-E servers:
     1. Select **Expressway-E server that provided TURN service**.
        
        **Important** The TURN relay and SIP signaling must reside on the same server.

     2. Under **Cisco Expressway-E Network Address Map**, enter the external IP addresses and internal IP addresses of each of the Cisco Expressway-E servers in the cluster. Mapping allows the Cisco Jabber Guest server to send the SIP to the same Cisco Expressway-E servers as the TURN relay.

        If static NAT mode is enabled on Cisco Expressway-E with either single NIC deployment or dual NIC deployment, the Cisco Jabber Guest server must be configured for static NAT mode as well.


---

**Step 4**  
Click **Update**.  
The message **Update successful** appears.

**Step 5**  
Restart Tomcat:  
```
service tomcat-as-standalone.sh restart
```

**Step 6**  
On the Cisco Expressway-E, verify that the neighbor zones for each Cisco Jabber Guest server are active:

   a) Choose **Configuration > Zones > Zones**.
   
   b) View the **SIP status** column.

---

**Configure Static NAT Mode on Cisco Expressway-E**

If static NAT mode is enabled on Cisco Expressway-E with either single NIC deployment or dual NIC deployment, the Cisco Jabber Guest server must be configured for static NAT mode as well. This allows the media to flow within the DMZ, avoiding NAT reflection (sending media to the NATed address).
Procedure

Step 1  Sign in to Cisco Jabber Guest Administration.
Step 2  Click Settings, and then click Call Control and Media.
Step 3  Under Cisco Expressway-E Network Address Map, check Static NAT mode.
        This check box appears only when the option Route calls using Cisco Expressway, is selected.
Step 4  Under Public IP (Static NAT), enter the static NAT IP address of the Cisco Expressway-E server.
Step 5  Under External IP (DMZ), enter the external IP address of the Cisco Expressway-E server.
Step 6  Repeat Steps 4 and 5 for each of the Cisco Expressway-E servers in the cluster.
Step 7  Click Update.

Configure TURN Credential Provisioning

The Cisco Jabber Guest client needs TURN credentials to allocate TURN relays on the Cisco Expressway-E. The Cisco Jabber Guest server provisions these credentials on the Cisco Expressway-C when the Cisco Jabber Guest client connects.

The Cisco Jabber Guest server uses an HTTP-based XML API to communicate with Cisco Expressway-C.

Procedure

Step 1  Sign in to Cisco Jabber Guest Administration as an administrator.
Step 2  Click Settings, and then click Call Control and Media.
Step 3  Under Cisco Expressway-C, for Expressway-C (IP address or DNS name), enter the Cisco Expressway-C IP address or DNS name.
Step 4  Specify whether short-term TURN credentials are requested from the Cisco Expressway-C that proxied the HTTP request from the Cisco Jabber Guest client or from the server entered in Step 3.
Step 5  For HTTPS port, specify the port.
Step 6  For Domain, enter the domain on Cisco Expressway-C that has Jabber Guest services enabled.
Step 7  For Username and Password, enter the username and password of the administrator account on Cisco Expressway-C that has read, write, and API access.
Step 8  Click Update.

Set Up TURN Server Information

The Cisco Jabber Guest client needs to know which Cisco Expressway-E to use for TURN relays.
Set FQDN of Cisco Jabber Guest Server

Procedure

Step 1  Sign in to Cisco Jabber Guest Administration as an administrator.
Step 2  Click Settings, and then click Call Control and Media.
Step 3  Enter the FQDN of the Cisco Jabber Guest server.

Important  The FQDN must match the value specified in the Cisco Jabber Guest Server hostname field on the Cisco Expressway-C. Cisco Expressway-C uses the FQDN to forward the per-session HTTP traffic to the appropriate Cisco Jabber Guest server in the cluster.

Step 4  Click Update.

What to do next

Make sure that you populate the Cisco Jabber Guest local FQDN field for each node in the Cisco Jabber Guest cluster.
Set Domain Used for Links

To create links on the Cisco Jabber Guest server, you must enter the Cisco Jabber Guest domain that is configured on the Cisco Expressway-C or the sub-domain of the Cisco Jabber Guest domain.

You also need to ensure that the appropriate DNS records exist so that the Cisco Jabber Guest client can reach the Cisco Expressway-E.

**Procedure**

**Step 1**  
Sign into Cisco Jabber Guest Administration as an administrator.

**Step 2**  
Click **Settings**, and then click **Links**.

**Step 3**  
For **Domain used for links**, enter the Cisco Jabber Guest domain that is configured on the Cisco Expressway-C. You can add a sub-domain for the Cisco Jabber Guest service. Make sure that the domain used for links has an associated DNS record that resolves to the public IP address of Cisco Expressway-E.

**Example:**

If yourcompany.com is configured as the Cisco Jabber Guest domain on Cisco Expressway-C and jg.yourcompany.com is configured on the Cisco Jabber Guest server, the format of the link is https://jg.yourcompany.com/call/<directory number>. And make sure there is a DNS record to resolve jg.yourcompany.com to the public IP address of Cisco Expressway-E.

**Step 4**  
Click **Update**.

**Related Topics**  
Set Redirect URL for Mobile Clients

Customize Cisco Jabber Guest Clients

**Important**

Do not to modify any files on the Cisco Jabber Guest server. For example, on the web client, editing the appearance of the Cisco Jabber Guest video window, such as the Call button, is not supported.

To change the appearance of the web page that contains the Cisco Jabber Guest video window, host the page on a server other than the Cisco Jabber Guest server.

The mobile client can be fully customized.

For more information about customizing Cisco Jabber Guest clients, go to the Cisco Jabber Guest SDK DevNet website.

**Related Topics**  
Cisco Jabber Guest SDK DevNet
Customize Long Polling and Call Session Expires

Cisco Jabber Guest client sends HTTP long polling to Cisco Jabber Guest server to communicate events and keep alive. We provide two advanced settings, **Client long-polling** and **Call session expires**, to control the long polling time intervals:

![Note]

The **Client long-polling** and **Call session expires** field configurations are supported only in Cisco Jabber Guest 10.6(10) and its later releases.

**Procedure**

**Step 1**  
Sign in to **Cisco Jabber Guest Administration**.

**Step 2**  
Click **Settings**, and then click **Advanced Settings**.

**Step 3**  
Enter a value in the **Client long-polling (seconds)** field.  
The permitted range of values is 5 to 60 seconds.  
The default value is 20 seconds.

**Step 4**  
Enter a value in the **Call session expires (seconds)** field.  
The permitted range of values is 5 to 60 seconds.  
The default value is 60 seconds.

**Step 5**  
Click **Update**.
Upgrade Cisco Jabber Guest Server

Cisco Jabber Guest Server is upgraded through vSphere on the Microsoft Windows platform. The upgrade is delivered as an ISO file, and requires a CD or DVD drive that can be connected to the image.

Procedure

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Download JabberGuest-11.x.x.x-Upgrade-Only.iso.</td>
</tr>
<tr>
<td>Step 2</td>
<td>Open vSphere.</td>
</tr>
<tr>
<td>Step 3</td>
<td>Browse to the virtual machine to upgrade.</td>
</tr>
<tr>
<td>Step 4</td>
<td>Right-click the virtual machine and select Open console.</td>
</tr>
</tbody>
</table>
| Step 5 | Connect the CD/DVD drive to the ISO image:  
  a) From the console of the virtual machine, click on the CD/DVD button whose icon image is a disk with a wrench.  
  b) Click the CD/DVD drive 1 menu item and then select the Connect to ISO image on local disk... menu item.  
  c) In the Open window, browse to the ISO image downloaded in Step 1 and double-click it. |
| Step 6 | Click inside the virtual machine console and sign in as root. |
| Step 7 | Under the /mnt directory, create a new directory named cdrom to use as the mount location for the CD/DVD drive.  
  mkdir /mnt/cdrom |
| Step 8 | Mount the CD/DVD drive to /mnt/cdrom:  
  mount /dev/cdrom /mnt/cdrom |
| Step 9 | Change directory to /mnt/cdrom:  
  cd /mnt/cdrom |
| Step 10 | Execute the upgrade script:  
  bash upgrade |
Step 11

To ensure that the latest version of Cisco Jabber Guest Administration is loaded in your browser, refresh any browser instances that are signed in to Cisco Jabber Guest Administration or that have the Cisco Jabber Guest Administration sign-in page loaded.
CHAPTER 5

Configure High Availability and Scalability

- Cluster, on page 49
- Configure Load Balancing, on page 55

Cluster

Create Cluster

In this procedure, we refer to the primary server as primary and to the two secondary servers as node A and node B.

Before you begin

When a secondary server joins a cluster, all of the data on the secondary server is discarded. If you need to retain the data for future use, back up the secondary server before joining it to the cluster.

Procedure

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Deploy the .OVA to all three servers.</td>
</tr>
<tr>
<td>Step 2</td>
<td>For all three Cisco Jabber Guest servers, make sure that you set the FQDN. For more information, see Set FQDN of Cisco Jabber Guest Server, on page 43.</td>
</tr>
<tr>
<td>Step 3</td>
<td>Sign in to each server as root.</td>
</tr>
</tbody>
</table>
| Step 4 | To establish the primary, on one of the three servers:  
  a) Type `cluster initiate`, and follow the on-screen prompts.  
     It takes a minute or two for the database to stabilize in its new configuration.  
  b) Verify that the database has stabilized by typing `cluster status`.  
     When the database has stabilized, the status shows: `--- > <IP address/hostname of primary> PRIMARY`.  
     The symbol `--- >` indicates the current server.  
  c) Restart Tomcat: `service tomcat-as-standalone.sh restart`. |
| Step 5 | To join node A to the cluster, on one of the remaining servers:  
  a) Type `cluster join <IP address/hostname of primary>`, and follow the on-screen prompts.  
     It takes a minute or two for the database to stabilize in its new configuration. |
b) Verify that the database has stabilized by typing `cluster status`. When the database has stabilized, the status shows: ```--- > <IP address/hostname of node A> SECONDARY.```  
c) Restart Tomcat: `service tomcat-as-standalone.sh restart`.

**Step 6**  
To join node B to the cluster, on the remaining server:  

a) Type `cluster join <IP address/hostname of primary>`, and follow the on-screen prompts.  
   It takes a minute or two for the database to stabilize in its new configuration.  
b) Verify that the database has stabilized by typing `cluster status`. When the database has stabilized, the status shows as: ```--- > <IP address/hostname of node B> SECONDARY.```  
c) Restart Tomcat: `service tomcat-as-standalone.sh restart`.

**Step 7**  
Allow node A to communicate with node B:  
a) Type `cluster allow <IP address/hostname of node B>`.

b) Verify that communication is allowed by typing `cluster status`. When communication is allowed, the status of node B changes from ```--- > <IP address/hostname of node B> not reachable/healthy to ```--- > <IP address/hostname of node B> SECONDARY.

**Step 8**  
Allow node B to communicate with node A:  
a) Type `cluster allow <IP address/hostname of node A>`.

b) Verify that communication is allowed by typing `cluster status`. When communication is allowed, the status of node A changes from ```--- > <IP address/hostname of node A> not reachable/healthy to ```--- > <IP address/hostname of node A> SECONDARY.

---

**What to do next**

For each of the three servers in the cluster, configure the appropriate SIP trunk in Cisco Unified Communications Manager or zones in Cisco TelePresence Video Communication Server, depending on the type of servers deployed in your network.

**Change IP Address or Hostname of Server in Cluster**

You can modify the IP address or hostname of a server in the cluster if it changes for any reason. In this procedure, we refer to the server that we change the IP address or hostname of as the *target server*.

**Procedure**

**Step 1**  
Make a note of the current IP address or hostname of the target server. You need to enter it during Step 4.b.

**Step 2** (Optional) If you are changing the IP address or hostname of the primary server, demote the primary server to a secondary server, otherwise proceed to Step 3:  
a) On the primary server, type `cluster stepdown`.

b) Verify that the target server has been demoted from the primary server to a secondary server by typing `cluster status`.

c) Make a note of which server is now the primary server.

**Step 3**  
Change the IP address or hostname of the target server.

**Step 4**  
In the cluster, change the IP address or hostname of the target server:
Configure High Availability and Scalability

Demote Primary Server to Secondary Server

You can demote or stepdown a primary server to a secondary server. For example, if you need to do maintenance on the primary server.

A new primary server is elected from the remaining servers in the cluster.

Procedure

Step 1  Sign in to the primary server as root.
Step 2  Type `cluster stepdown`.

Step 5  On the other secondary server (node B), block communication from the old IP address or hostname of the target server and allow communication with the new IP address or hostname of the target server:

a) Sign in to node B as root.
b) On node B, block communication from the old IP address or hostname of the target server by typing `cluster disallow <old IP address/hostname of target server>`.
c) On node B, allow communication with the new IP address or hostname of the target server by typing `cluster allow <new IP/hostname of target server>`.

Step 6  Make sure that each server in the cluster is healthy by typing `cluster status`.

Step 7  On the target server, restart Tomcat:

```
  service tomcat-as-standalone.sh restart
```

Step 8  If you changed the IP address or hostname of the primary server, in Cisco Jabber Guest Administration, update the domain used for links:

a) Sign in to Cisco Jabber Guest Administration as an administrator.
b) Click Settings, and then click Links.
c) For Domain used for Links, enter the IP address or hostname of the new primary server.
d) Click Update.

What to do next

If you are using a self-signed certificate, you must generate a new certificate after you change the IP address or hostname of the server.

Related Topics

- Change Virtual Machine Properties of a vCenter-hosted Server, on page 59
- Change Virtual Machine Properties of a UC Virtualization Foundation, UC Virtualization Hypervisor, or ESXi-hosted Server, on page 59
- Generate New Self-Signed Certificate, on page 31
Step 3 Verify that the server has been demoted to secondary by typing `cluster status`.

Upgrade Cluster

In this procedure, we refer to the primary server as *node A* and to the two secondary servers as *node B* and *node C*.

Procedure

**Step 1** Make a note of which nodes are the primary and secondary servers:
- a) Sign in to one of the Cisco Jabber Guest servers as root.
- b) Type `cluster status`.

**Step 2** Make sure that you have backed up each server in the cluster.

**Step 3** Download `JabberGuest-11.x.x.x-Upgrade-Only.iso`.

**Step 4** Open vSphere Client.

**Step 5** If a CD/DVD drive is not connected to the virtual machine, add one:
- a) In the Virtual Machine Properties window, click the Hardware tab, and then click Add to bring up the Add Hardware window.
- b) In the Add Hardware window, select CD/DVD Drive as the device type, and then click Next.
- c) For the CD/DVD Media type, click Use physical drive, and then click Next.
- d) Accept the default CD/DVD drive when prompted to select a drive, and then click Next.
- e) In the Advanced Options settings, accept the default values, and then click Next.
- f) In the Ready to Complete window, click Finish.
- g) In the Virtual Machine Properties window, click OK.

**Step 6** On each server, connect the CD/DVD drive to the ISO image:
- a) In the virtual machines and templates inventory tree, select the virtual machine.
- b) Click the Connect/disconnect the CD/DVD devices of the virtual machine button. The button icon is a disk with a wrench.
- c) Point to **CD/DVD drive 1**, and then click Connect to ISO image on local disk.
- d) In the Open window, browse to the ISO image downloaded in Step 2 and double-click it.
It takes a little while to connect to the ISO image. When connected, in the Recent Tasks list, the status of the Connect task shows Completed.

**Step 7** Prepare to upgrade node B by updating the reverse proxy so that call requests are sent to node A first, node C second, and no call requests are sent to node B:
- a) On Cisco Expressway-C, choose Configuration > Unified Communications > Configuration.
- b) Under Jabber Guest, click Configure Jabber Guest servers.
- c) In the row for node A, click View/Edit, change the value for Priority to 1, and click Save.
- d) In the row for node B, click View/Edit, change the value for Priority to 0, and click Save.
- e) In the row for node C, click View/Edit, change the value for Priority to 2, and click Save.

**Step 8** Make sure that there are no calls on node B:
- b) In the row for node B, wait until the Calls column show 0 calls.
Step 9 Upgrade node B by doing the following:
a) Sign into the server as root.
b) Under the /mnt directory, create a new directory named cdrom to be used as the mount location for the CD/DVD drive:
   
   mkdir /mnt/cdrom

c) Mount the CD/DVD drive to /mnt/cdrom:
   
   mount /dev/cdrom /mnt/cdrom
   
   When the CD/DVD drive is mounted, the following message appears: 
   mount: block device /dev/sr0 is write-protected, mounting read only.
d) Change directory to /mnt/cdrom:
   
   cd /mnt/cdrom

e) Execute the upgrade script:
   
   bash upgrade

   When the upgrade is complete, the following message appears: The log file, for this upgrade, can be found in /var/log/webcommon/upgrade.log.

Step 10 Prepare to upgrade node C by updating the reverse proxy so that call requests are sent to node A first, node B second, and no call requests are sent to node C:

a) On Cisco Expressway-C, choose Configuration > Unified Communications > Configuration.
b) Under Jabber Guest, click Configure Jabber Guest servers.
c) In the row for node A, leave the priority set to 1.
d) In the row for node B, click View/Edit, change the value for Priority to 2, and click Save.
e) In the row for node C, click View/Edit, change the value for Priority to 0, and click Save.

Step 11 Make sure that there are no calls on node C:

a) On Cisco Expressway-C, choose Configuration > Zones > Zones.
b) In the row for node C, wait until the Calls column show 0 calls.

Step 12 Upgrade node C by repeating Step 9.

Step 13 Verify that node B and node C are back up and running by signing in to Cisco Jabber Guest Administration as an administrator.

a) Confirm that the Cisco Jabber Guest version number to which you upgraded appears at the bottom of the screen.
b) Check to make sure that all users and links look correct.

Step 14 Prepare to upgrade node A by updating the reverse proxy so that call requests are sent to node C first, node B second, and no call requests are sent to node A:

a) On Cisco Expressway-C, choose Configuration > Unified Communications > Configuration.
b) Under Jabber Guest, click Configure Jabber Guest servers.
c) In the row for node A, click View/Edit, change the value for Priority to 0, and click Save.
d) In the row for node B, leave the priority set to 2.
e) In the row for node C, click View/Edit, change the value for Priority to 1, and click Save.

Step 15 Wait until there are no calls on node A:

a) On Cisco Expressway-C, choose Configuration > Zones > Zones.
b) In the row for node C, wait until the Calls column show 0 calls.
This may take a few minutes because this server handled all of the calls while the other two servers were upgraded.

**Step 16**

Demote node A to a secondary server:

a) Type `cluster stepdown`.

b) Verify that either node B or node C has been promoted to primary server by typing `cluster status`.

Make sure that the status of either node B or node C shows:

```
---<IP address/hostname of node B or node C> PRIMARY.
```

**Step 17**

Upgrade node A by repeating Step 9.

**Step 18**

Verify that node A is back up and running by signing in to Cisco Jabber Guest Administration as an administrator.

The Cisco Jabber Guest version number to which you upgraded appears at the bottom of the screen.

**Step 19**

Promote node A to the primary server:

a) On the server that is currently the primary, type `cluster stepdown`.

b) Check to see if node A was promoted to primary by typing `cluster status`.

If node A is the primary, the status shows:

```
---<IP address/hostname of node A> PRIMARY.
```

c) If node A was not promoted to primary, repeat Step 12.a until node A is promoted to the primary server.

**Step 20**

Update the order of the reverse proxy.

**Step 21**

To ensure that the latest version of Cisco Jabber Guest Administration is loaded in your browser, refresh any browser instances that are signed in to Cisco Jabber Guest Administration or that have the Cisco Jabber Guest Administration sign-in page loaded.

---

**Remove Server from Cluster**

---

**Important**

After a server is removed from a cluster, it cannot be run as a standalone Cisco Jabber Guest instance. To do this, the server must be reinstalled.

In this procedure, we refer to the secondary server that we want to remove as node *A*, and to the other secondary server as node *B*.

**Procedure**

**Step 1**

Sign into each server in the cluster as root.

**Step 2**

On the primary server:

a) Type `cluster remove <IP address/hostname of node A>`, and follow the on-screen prompts.

b) Verify that node A is removed from the cluster by typing `cluster status`.

Node A is removed from the list of servers.

**Step 3**

On node A, block communication from node B by typing `cluster disallow <IP address/hostname of node B>`.
Step 4
On node B, block communication with node A by typing `cluster disallow <IP address/hostname of node A>`.

## Configure Load Balancing

### Configure Round-Robin DNS Load Balancing

With round-robin DNS load balancing, a DNS server returns an ordered list of IP addresses associated with a single host name. With each new query on that host name, the DNS server rotates through the list. Multiple servers at different IP addresses take turns handling new requests to provide the same service.

For TURN traffic, an advantage of round-robin DNS load balancing is that it also provides redundancy. If a TURN server is down or unreachable, the client tries another server.

---

**Note**
The order of the IP address list returned for a DNS lookup is difficult to predict if the DNS server is under any kind of load directed at the host name. The important thing to expect is that calls to the host name go to different servers over time.

---

**Procedure**

**Step 1**
Make sure that the DNS server has round-robin enabled.

**Step 2**
Make sure that the FQDNs for the Cisco Expressway-C and Cisco Expressway-E clusters are configured on the DNS server to round-robin through the IP addresses of the server cluster.

**Step 3**
Sign into Cisco Jabber Guest Administration as an administrator.

**Step 4**
Click Settings, and then click Call Control and Media.

**Step 5**
To set up round-robin DNS for the SIP server:
- a) For SIP server, enter the FQDN of the Cisco Expressway-C cluster.
- b) Next to Send SIP traffic to, click SIP server specified above.

**Step 6**
To set up round-robin DNS to request short-term TURN credentials from Cisco Expressway-C:
- a) For Expressway-C (IP address or DNS name), enter the FQDN of the Cisco Expressway-C cluster.
- b) Next to Request short-term TURN credentials from, click Expressway-C server specified above.

**Step 7**
To set up round-robin DNS for the TURN server: For Expressway-E TURN server (IP address or DNS name), enter the FQDN of the Cisco Expressway-E cluster.
Successive clients making TURN requests to that cluster FQDN are directed to different servers in the Cisco Expressway-E cluster; however, whether and how a particular client uses round-robin DNS for subsequent calls can be influenced by DNS caching.

**Step 8**
Click Update.

Round-robin DNS takes effect if the Cisco Jabber Guest call URL that is used by a client browser to make a Cisco Jabber Guest call uses the FQDN for the Cisco Expressway-E cluster.
What to do next

To ensure that the number of new call requests does not exceed the capacity of the Cisco Expressway-C, make sure that you change the SIP call throttle limit.

**Change the SIP Call Throttle Limit**

To ensure that the rate of new call requests (SIP INVITES) does not exceed the capacity of the Cisco Expressway-C, the Cisco Jabber Guest server implements a call throttling mechanism.

For a clustered Cisco Expressway-C deployment in which load balancing is achieved by round-robin DNS, we recommend that you change the SIP call throttle limit to 10 multiplied by the number of servers in the Cisco Expressway-C cluster to which Cisco Jabber Guest sends SIP. For example, if there are two servers in the Cisco Expressway-C cluster, set the SIP call throttle limit to 20.

If the rate of new calls exceeds the throttle limit, Cisco Jabber Guest delays a small amount of time before processing those calls that exceed the throttle limit. This throttling should not be noticed by users.

**Procedure**

**Step 1** Sign in to Cisco Jabber Guest Administration as an administrator.

**Step 2** Click **Settings**, and then click **Advanced Settings**.

**Step 3** In the **SIP call throttle limit (new calls/second)** box, type or select the throttle limit.

**Step 4** Click **Update**.

**Configure Round-Robin CSV Loading Balancing**

With round-robin CSV load balancing, a Cisco Jabber Guest server can be configured to make requests, in round-robin order, across individually specified servers by using a CSV list. After a server is used, the next server on the list is used, until the choice rotates to the beginning of the list and then repeats.

**Procedure**

**Step 1** Sign in to Cisco Jabber Guest Administration as an administrator.

**Step 2** Click **Settings**, and then click **Call Control and Media**.

**Step 3** To set up a CSV list for the SIP server:
   a) For **SIP server**, enter a list of IP addresses or FQDNs for individual Cisco Expressway-C servers. The list of IP addresses or FQDNs must be separated by commas and must not contain spaces.

   **Example:**
   expressway-c-1.somedomain.com,expressway-c-2.somedomain.com,expressway-c-3.somedomain.com
   
   b) Next to **Send SIP traffic to**, click **SIP server specified above**.

**Step 4** To set up a CSV list to request short-term TURN credentials from Cisco Expressway-C:
   a) For **Expressway-C (IP address or DNS name)**, enter a list of IP addresses or FQDNs for individual Cisco Expressway-C servers. The list of IP addresses or FQDNs must be separated by commas and must not contain spaces.
Configure HTTP Load Balancing

Cisco Jabber Guest server can take advantage of HTTP load balancing from the Cisco Expressway-C by sending SIP and TURN credential requests to the Cisco Expressway-C that sent the HTTP.

Procedure

Step 1 Sign in to Cisco Jabber Guest Administration as an administrator.
Step 2 Click Settings, and then click Call Control and Media.
Step 3 To send SIP to the Cisco Expressway-C that sent the HTTP, next to Send SIP traffic to, click Expressway-C server that proxied the HTTP request from Jabber Guest client.
Step 4 To send TURN credential requests to the Cisco Expressway-C that sent the HTTP, next to Request short-term TURN credentials from, click Expressway-C server that proxied the HTTP request from Jabber Guest client.
Step 5 Click Update.

Configure Round-Robin TURN Port Range Load Balancing

You can configure Cisco Jabber Guest to take advantage of the load-balancing potential for TURN requests by using different TURN ports for each successive TURN request.

On a large Cisco Expressway-E deployment, up to six TURN request ports can be specified as a range. When used in combination with round-robin DNS or round-robin CSV for TURN servers, this multiplies the number of TURN request ports in use.

Procedure

Step 1 Sign in to Cisco Jabber Guest Administration as an administrator.
Step 2 Click Settings, and then click Call Control and Media.
Step 3 For TURN port, enter a hyphenated range of port numbers that matches the range of TURN request ports configured on Cisco Expressway-E (under Configuration > Traversal > TURN).
Example:
3478-3483

Step 4  Click Update.
Post-Install Configuration Changes

- Change Virtual Machine Properties of a vCenter-hosted Server, on page 59
- Change Virtual Machine Properties of a UC Virtualization Foundation, UC Virtualization Hypervisor, or ESXi-hosted Server, on page 59

Change Virtual Machine Properties of a vCenter-hosted Server

You can change the properties of a virtual machine, such as its IP address or hostname.

Procedure

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>In the Virtual Machine tab of vSphere, click the Configure virtual machine link.</td>
</tr>
<tr>
<td>Step 2</td>
<td>Click the Options tab.</td>
</tr>
<tr>
<td>Step 3</td>
<td>Under vApp Options, click Properties.</td>
</tr>
<tr>
<td>Step 4</td>
<td>Edit the properties, as required.</td>
</tr>
<tr>
<td>Step 5</td>
<td>Click OK.</td>
</tr>
<tr>
<td>Step 6</td>
<td>Turn on the virtual machine:</td>
</tr>
<tr>
<td></td>
<td>a) In the virtual machines and templates inventory tree, right-click the virtual machine.</td>
</tr>
<tr>
<td></td>
<td>b) Choose Power &gt; Power On.</td>
</tr>
</tbody>
</table>

Change Virtual Machine Properties of a UC Virtualization Foundation, UC Virtualization Hypervisor, or ESXi-hosted Server

You can change the properties of a virtual machine, such as its IP address or hostname.

Procedure

| Step 1 | Sign in to the virtual machine directly from the virtual machine console or by using a Secure Shell client such as SSH. |
Step 2  Change directory to /etc/jabberguest:
  cd /etc/jabberguest

Step 3  Copy the file network.config.sample to a file named network.config:
  cp network.config.sample network.config

Step 4  Edit the properties in network.config:
  vi network.config

Step 5  To configure the virtual machine with a static IP address, you must edit the hostname, IP address, gateway IP address, network mask, and at least one DNS server IP address.

  Important  Do not include quotation marks around the domain name or hostname.

Step 6  Check the properties:
  cd /opt/cisco/webcommon/scripts
  python networking.py -dryrun

Step 7  Restart the virtual machine:
  shutdown -r now

Related Topics
  Install Server to ESXi, UC Virtualization Foundation, or UC Virtualization Hypervisor, on page 25
CHAPTER 7

Troubleshoot

- Locate chip.log File, on page 61
- Locate chip.dmp File, on page 62
- Reset Admin Password for Cisco Jabber Guest Administration, on page 62
- Reset Root Password for Cisco Jabber Guest Server, on page 62
- Audio and Video Issues, on page 64
- Call Links Redirect to Cisco Expressway-E Web Page, on page 66
- Plug-in Crashes, on page 66
- Jabber Guest Web Administrator Page Does Not Load, on page 66
- Error Messages, on page 67

Locate chip.log File

If you are asked to send the chip.log file, use the following procedure.

Procedure

**Step 1**

Do one of the following:

- For Windows, navigate to `%HOMEPATH%\Appdata\LocalLow\Cisco\chip`.  
  **Note**  
  `%HOMEPATH%` is generally of the form ‘C:\Users\username’.

- For Safari and Firefox (49 or below) on Mac OS X, navigate to ~/Library/"Internet Plug-Ins"/"Cisco Jabber Guest Plug-in.version-number.plugin"/Contents/Frameworks/Logs.

- For Chrome and Firefox (50 or later) on Mac OS X, navigate to ~/Applications/"Cisco Jabber Guest Add-on.version-number"/Contents/Frameworks/Logs

**Step 2**

Compress the file and email it back to the requester.
Locate chip.dmp File

If your plug-in crashes, a dump file called chip.dmp is created. Currently, this file is created only for plug-in crashes on Microsoft Windows. If you are asked to send the chip.dmp file, follow this procedure.

Procedure

**Step 1**  
Navigate to %HOMEPATH%\Appdata\LocalLow\Cisco\chip.

*Note*  
%HOMEPATH% is generally of the form 'C:\Users\username'.

**Step 2**  
Compress the file and email it back to the requester.

Reset Admin Password for Cisco Jabber Guest Administration

Procedure

**Step 1**  
Sign in to the Cisco Jabber Guest server as root.

**Step 2**  
Change directory to /opt/cisco/webcommon/scripts:

```
cd /opt/cisco/webcommon/scripts
```

**Step 3**  
Enter the following command:

```
python mongo_admin_reset.py
```

The password is reset to its default value: jabbercservr.

Reset Root Password for Cisco Jabber Guest Server

Procedure

**Step 1**  
Open a console session for the Cisco Jabber Guest server and restart the server.

**Step 2**  
Press any key to interrupt the start process.

**Step 3**  
Press e to edit.

**Step 4**  
From the entries, select kernel and press e to edit.
Step 5  Start the server in single-user mode:
   a) Add the word **single** to the end of the line.
   b) Press the **Enter** key.

Step 6  Press **b** to start the server.
The Cisco Jabber Guest server starts in single-user mode.
Step 7 Enter `passwd root`, and then enter a new password.
Step 8 Restart the server.

Audio and Video Issues

One-Way Video When Using VPN

**Problem** Callers experience one-way video when using Cisco Jabber Guest over VPN.

**Possible Cause** The default Maximum Transmission Unit (MTU) on Cisco Expressway-E is too high and can cause packet loss.

**Solution** Change the MTU.

**Related Topics**

Change MTU Size, on page 38

No Audio or Video on Single NIC Deployment

**Problem** No audio or video on single NIC deployment; media is terminating on the Cisco Expressway-E

**Possible Cause** On the Cisco Expressway-C, for the zone to the Cisco Jabber Guest server, Media encryption mode is not set to Best effort.

**Solution** Set Media encryption mode to Best effort. Best effort forces media from the Cisco Expressway-E to terminate on the Cisco Expressway-C.
Don't See Screen Share in Production Deployment

**Problem** Callers don't see the screen share.

**Possible Cause** User Datagram Protocol (UDP)/Binary Floor Control Protocol (BFCP) settings have changed and the BFCP session may not be negotiated.

**Solution** On the Cisco Expressway-C, make sure that SIP UDP/BFCP filter mode is set to Off. On Cisco Unified Communications Manager, for endpoints that support BFCP and SIP trunk to Cisco Expressway-C, make sure that the SIP Profile is set to Allow Presentation Sharing using BFCP. For more information, see Check BFCP Settings for Screen Sharing.

**Related Topics**
- Check BFCP Settings for Screen Sharing, on page 65

---

**Check BFCP Settings for Screen Sharing**

By default, Cisco Expressway-C passes the User Datagram Protocol (UDP)/Binary Floor Control Protocol (BFCP) setting untouched to and from Cisco Unified Communications Manager. That is, the SIP UDP BFCP filter mode setting, which determines whether INVITE requests sent to this zone filter out UDP/BFCP is set to Off. If the setting is set to On, UDP/BFCP settings are modified and the BFCP session may not be negotiated.

**Procedure**

**Step 1** On the Cisco Expressway-C setting, do one of the following:

- From the administrator command-line interface, enter the following command:

  ```sh
xConfiguration Zones Zone <index> Neighbor SIP UDP BFCP Filter Mode: <On/Off>
  ```

  Make sure that SIP UDP/BFCP filter mode is set to Off. Off means that INVITE requests are not modified; On means that any media line referring to the UDP/BFCP protocol is replaced with TCP/BFCP and disabled.

  ```sh
  Configuration Zones Edit Zones Advanced
  ```

- From the administrator web page, "Configuration Zones Edit Zones Advanced," set the profile to Custom and make sure that SIP UDP/BFCP filter mode is set to Off.

**Step 2** On Cisco Unified Communications Manager, for endpoints that support BFCP and SIP trunk to Cisco Expressway-C, make sure that the SIP Profile is set to Allow Presentation Sharing using BFCP.

---

Don't See Screen Share in Lab Deployment

**Problem** In a lab deployment in which Cisco Jabber Guest is pointed directly to Cisco Unified Communications Manager, without configuring Expressway, callers see a black screen instead of the screen share.

**Possible Cause** The media stream is blocked by a firewall.
**Solution** Enable a client-side firewall rule to allow the incoming screen share.

## Call Links Redirect to Cisco Expressway-E Web Page

**Problem** Call links redirect to the Cisco Expressway-E web page.

**Possible Cause** The Cisco Expressway-E administrator already uses ports 80 and 443.

**Solution** Remap incoming requests from the Cisco Jabber Guest client to Cisco Expressway-E on ports 80 and 443 to ports 9980 and 9443, respectively, using a firewall or similar in front of Cisco Expressway-E. For the mobile client, using 9980 or 9443 in call links is not supported; you must use port remapping on your firewall to remap port 80 to port 9980 and port 443 to port 9443.

**Related Topics**
- Ports and Protocols, on page 15
- Set Domain Used for Links, on page 44
- Set Redirect URL for Mobile Clients

## Plug-in Crashes

**Problem** The plug-in crashes.

**Possible Cause** The video drivers may not be current.

**Solution** Make sure that the video drivers are up to date on the system.

## Jabber Guest Web Administrator Page Does Not Load

**Problem** The Cisco Jabber Guest Web Administrator page does not load after a Cisco Jabber Guest server restart.

**Possible Cause** The webcommon-ui service might not have been started properly.

**Solution** Restart the webcommon-ui service manually using the following procedure:

**Procedure**

1. Sign in to the Cisco Jabber Guest server as root.
2. Change directory to `/etc/init.d`
3. Execute the following command:
   ```bash```
   service webcommon-ui restart
```
# Error Messages

**Table 18: Error Messages**

<table>
<thead>
<tr>
<th>Location</th>
<th>Error Message</th>
<th>What It Means</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cisco Jabber Guest</td>
<td>&quot;IOException closing sock javax.net.ssl.SSLHandshakeException: General SSLEngine problem&quot; appears in the Cisco Jabber Guest webcommon-tomcat.log file.</td>
<td>When one of these messages appears, it may indicate a problem with the Expressway certificate that is uploaded to Cisco Jabber Guest Administration. Verify that the Expressway certificate that is uploaded to Cisco Jabber Guest Administration is either an Expressway certificate or the CA certificate that signed it:</td>
</tr>
<tr>
<td>webcommon logs</td>
<td></td>
<td>1. Check the common name (CN) of the issuer and the subject of the certificate that is uploaded to Expressway:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3. Click Show (decoded).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2. Check the CN of the issuer and the subject of the certificate that is uploaded to Cisco Jabber Guest Administration:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1. Sign in to Cisco Jabber Guest Administration.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2. Click Settings, and then click Secure SIP Trust Certificate.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3. Make sure that Tomcat was restarted:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>service tomcat-as-standalone.sh restart</td>
</tr>
<tr>
<td>Cisco Expressway Event Log</td>
<td>tvc: Event=&quot;Outbound TLS Negotiation Error&quot; Service=&quot;SIP&quot;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Src-ip=&quot;&lt;ip address&gt;&quot; Src-port=&quot;27510&quot; Dst-ip=&quot;&lt;ip address&gt;&quot; Dst-port=&quot;5061&quot;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Detail=&quot;No SSL error available, probably remote disconnect&quot; Protocol=&quot;TLS&quot;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Level=&quot;1&quot; UTCTime=&quot;yyyy-mm-dd hh:mm:ss,732&quot;</td>
<td></td>
</tr>
<tr>
<td>On Cisco Expressway, status of zone for Cisco Jabber Guest server shows Failed</td>
<td>SIP: Failed to connect to &lt;IP address&gt;:5061 : TLS negotiation failure</td>
<td></td>
</tr>
</tbody>
</table>
## Error Messages

<table>
<thead>
<tr>
<th>Location</th>
<th>Error Message</th>
<th>What It Means</th>
</tr>
</thead>
</table>
| Cisco Jabber Guest client | Failed to acquire TURN credentials | This message may mean that the call control and media settings for Cisco Expressway-C may not be configured correctly. Check the settings:  
1. Sign in to Cisco Jabber Guest Administration as an administrator.  
2. Click **Settings**, and then click **Call Control and Media**.  
3. Under Cisco Expressway-C, if **Request short-term TURN credentials from** is set to **Expressway-C server specified above**, make sure that the value in the **Expressway-C (IP address or DNS name)** field is correct.  
4. Check the value in the **HTTP port** field. The default value is 443.  
5. Check the values in the Cisco Expressway-C administrator **Username** and **Password** fields:  
   - The administrator account is created on the Cisco Expressway-C (**Users > Administrator accounts**).  
   - The Cisco Expressway-C administrator must have read-write and API access.  
6. Check **Cisco Expressway-C server certificate** or **Cisco Expressway-C certificate authority** certificate.  
   It must use RSA keys greater than or equal to 1024 bits and must not be signed with MD5. |
<p>| Cisco Jabber Guest client | Link Not Found                  | Make sure that the link is active: Click <strong>Links</strong>, click the link, and check the <strong>State</strong> settings to make sure that the link has not expired. |</p>
<table>
<thead>
<tr>
<th>Location</th>
<th>Error Message</th>
<th>What It Means</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cisco Jabber Guest client</td>
<td>Link not valid</td>
<td>This message may mean that the link that has not yet been replicated to the Cisco Jabber Guest server that handles the request.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>When you create a click-to-call link on a Cisco Jabber Guest server that is a member of a cluster, you must allow a small amount of time before that link is active on all servers in the cluster.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If you deploy an application that creates links dynamically by using the link API and pushes them to the Cisco Jabber Guest client, we recommend that you factor this replication delay into your design.</td>
</tr>
<tr>
<td></td>
<td>Missing SDP. There was a networking error between your device and the server.</td>
<td>This message may mean that Cisco Jabber Guest is unable to contact the TURN server. One possible cause is that multiple network interfaces are enabled, including SW VPN. Another possible cause is that a firewall or NAT blocking UDP port 3478 between the client and the Cisco Expressway-E (publicly accessible IP). Some home routers block all UDP.</td>
</tr>
<tr>
<td></td>
<td>Not found on Accelerator</td>
<td>You may see this message because the link between the Cisco Expressway-C and Cisco Expressway-E is down and domain information hasn't replicated from the Cisco Expressway-C to Cisco Expressway-E.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>On Cisco Expressway-E, when viewing Unified Communications status (choose Status &gt; Unified Communications and click View ssh tunnel status), make sure that:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The Cisco Jabber Guest domain is listed.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The SSH tunnel is active.</td>
</tr>
<tr>
<td></td>
<td>Server error: class java.lang.IllegalStateException: Error creating sipServletRequest ROAP_EXCEPTION</td>
<td>Apache Tomcat may not be running, perhaps after an upgrade or server interruption.</td>
</tr>
</tbody>
</table>
### Error Messages

<table>
<thead>
<tr>
<th>Location</th>
<th>Error Message</th>
<th>What It Means</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cisco Jabber Guest client</td>
<td>SIP Error. The destination associated with this link is not reachable.</td>
<td>You may see this message for one of the following reasons:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The directory number (DN) embedded in the link or associated with the link, does not exist on the Cisco Unified Communications Manager.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The link contains a URI (<a href="mailto:user@domain.com">user@domain.com</a>) but the Cisco Unified Communications Manager is not configured to route calls by URI. Use a DN instead.</td>
</tr>
<tr>
<td></td>
<td>TERN Error. Your call attempt has failed due to incompatibility with your home or company security infrastructure. Please contact your network administrator or check your home network security settings.</td>
<td>This message indicates that the web client could not allocate the TURN relay on the TURN server. This could occur for one of the following reasons:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• UDP port 3478 is blocked. You must allow this port inbound from the public Internet to the Cisco Expressway-E.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The DNS record for the TURN server is not resolvable (must be a DNS A-record).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The Expressway-E TERN Server (IP Address or DNS Name) field and Turn Port fields are not configured correctly in Cisco Jabber Guest Administration</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The Domain name (Settings &gt; Call Control and Media, under Cisco Expressway-C) is not a configured domain name on Cisco Expressway-C or is not configured for Cisco Jabber Guest services.</td>
</tr>
</tbody>
</table>

**Related Topics**

- Set Up TURN Server Information, on page 42
- Configure Cisco Expressway-E and Cisco Expressway-C: Cisco Expressway-E with Single NIC Deployment, on page 33
- Configure TURN Credential Provisioning, on page 42
Reference

- Cisco Unified Communications Manager, on page 71
- Cisco Unified Communications Manager/Cisco Expressway Configuration Checklist, on page 72

Cisco Unified Communications Manager

- Documentation Home
- Documentation Guide for Cisco Unified Communications Manager, Release 8.6(2a)
- Documentation Guide for Cisco Unified Communications Manager, Release 9.1(1)
- Documentation Guide for Cisco Unified Communications Manager, Release 10.5(1)
  http://www.cisco.com/c/en/us/td/docs/voice_ip_comm/cucm/docguide/10_5_1/CUCM_BK_C2CFB1F8_00_cucm-documentation-guide-1051.html
- Documentation Guide for Cisco Unified Communications Manager, Release 11.0(1)
- Documentation Guide for Cisco Unified Communications Manager, Release 11.5(1)
Cisco Unified Communications Manager/Cisco Expressway Configuration Checklist

Prepare to Install

• Use Cisco Unified Communications Manager 8.6.x or later.

• Configure Cisco Unified Communications Manager to work with Cisco Expressway or Cisco TelePresence Video Communication Server Control (VCS).

Cisco Jabber Guest can point directly to Cisco Unified Communications Manager for lab deployments only. Without configuring Cisco Expressway or Cisco VCS, Cisco Jabber Guest is not supported in a production environment.

Perform Initial Setup

• On Cisco Unified Communications Manager, set up a non-secure or secure Session Initiation Protocol (SIP) trunk and point it to the Cisco Expressway-C.

For more information, see the Cisco Unified Communications Manager with Cisco Expressway (SIP Trunk) Deployment Guide.

• On Cisco Expressway-C, set up a neighbor zone and point it to Cisco Unified Communications Manager.

For more information, see the Cisco Expressway Basic Configuration Deployment Guide.

• Add a search rule on Cisco Expressway-C to route calls to Cisco Unified Communications Manager.

For more information, see the Cisco Expressway Basic Configuration Deployment Guide.

• For dual NIC deployments, also add a search rule on the Cisco Expressway-E to route call to the Cisco Expressway-C.

• Set up a Unified Communications traversal zone between the Cisco Expressway-C and the Cisco Expressway-E. Set the traversal zone type to Unified Communications traversal.

For more information, see the Cisco Expressway Administrator Guide.

Creating Links

• Make sure that the part of the link after /call resolves to a directory number (DN) or uniform resource identifier (URI) that is routable on Cisco Expressway-C and Cisco Unified Communications Manager.

• For dual NIC deployments, also make sure that the part of the link after /call resolves to a DN or URI that is routable on Cisco Expressway-E.